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Linear Nonlinear

WORKSHOP 1
LINEAR AND NONLINEAR

ANALYSIS OF A CANTILEVER BEAM
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• Workshop Objectives

– Small vs. large displacement analysis.

– Linear elastic theory.

• Software Version

– Patran 2013

– MSC Nastran 2013.1

• Files Required

– No supporting file is required.

• Problem Description

– The simulation is to use 3D solid finite elements. The elements are
uniformly spaced along the length of the beam (i.e. a mesh 100 elements
wide and four elements deep).
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• Problem Description (Cont.)

– In this exercise, a cantilever beam is subjected to a static load. The beam is
initially analyzed using small deformation theory. However, after reviewing
the results, it becomes apparent that small deformation theory is not
appropriate for this problem. Subsequently, a large deformation analysis is
performed and its results are compared to the small deformation analysis.

Section A-A

b

a

(Data in next page)
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• Problem Description (Cont.)

Length, L 100.0 in 2.54 m

a 1.0 in 25.4 mm

b 2.0 in 50.8 mm

Young’s Modulus 30.0 x 106 lb/in3 207 GPa

Poisson’s Ratio 0.3 0.3

P 6000 lb 27200 N

Section A-A

b

a
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• Suggested Steps

1. Create a new database called tip_load.

2. Create simple cantilever beam solid using XYZ vector coordinates
<100, 2, 1>

3. Apply a mesh seed to the model.

• Select number of elements as 100 along the curve oriented in the X
direction.

• Select number of elements as 4 along the curve oriented in the Y direction.

4. Mesh the solid using an isomesh with hex8 topology and a global
edge length of 1.0.

5. Create an isotropic material with an elastic modulus of 30e6,
Poisson’s ratio of 0.30, and a density of .00074.

6. Create 3D solid physical property for entire model and apply isotropic
material.

7. Fix translations in all directions along the left surface to create
cantilever.

8. Apply load of 1500 in the -Y direction to points on right end.

9. Create and run a linear static analysis.

10. Attach the .op2 when the analysis is completed.
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• Suggested Steps

11.Create a quickplot with fringe and deformation of displacement results.

12.Create and run an implicit nonlinear analysis.

• In Solution Parameters select SOL400 Run.

• Select .op2 as results output format.

• Create a my_nonlinear subcase.

– Change the increment type to Adaptive stepping

• Run analysis with the my_nonlinear subcase.

13.Attach .op2 result file.

14.Create a quickplot with fringe and deformation of the y component of the
displacement results.

15.Compare the linear and nonlinear results.

16.Try to improve results.
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Create a new database. Name it
Tip_Load.db.

a. Pull down File > New.

b. Enter Tip_Load as the File
name.

c. Click OK.

d. Wait a few seconds until the
New Model Preference opens.

e. Confirm MSC Nastran as the
Analysis Code.

f. Click OK.

Step 1. Create New Database

a

b c

d

e

f

To make this exercise as easy as
possible to follow, the location on the
form where the operation will be
carried out will be pointed out by a
red-circled letter that corresponds to
the exercise step letter.

Where possible, the forms will be
shown as they will appear after the
instructions have been correctly
followed.
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Create the solid.

a. Under the Geometry tab,
pull down Select > XYZ
in the Solids group.

b. Enter <100 2 1> as the
Vector Coordinates List.

c. Click Apply.

d. Under the Home tab,
click on the Iso 1 View
icon in the Orientation
group.

Step 2. Create Cantilever Beam

b

c

d

a
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After second -Apply- the mesh
seeds will look like these:

After first -Apply- the mesh
seeds will look like these:

i

Create the finite element mesh seeds.

a. Under the Meshing tab, click Uniform in the Mesh
Seeds group.

b. Enter 100 as the Number.

c. Click in the Curve List panel.

d. Select Edge from the Picking Filters tool bar.

e. Pick one of the bottom edges on the solid.

f. Enter 4 as the Number.

g. Uncheck Auto Execute.

h. Click in the Curve List box

i. Pick, on the left end of the solid, a vertical edge.

j. Click Apply.

Step 3. Apply Mesh Seeds

e

g

j

h

fb

c

See note on
next page

a

d



NAS400, Workshop 1, January 2015
Copyright© 2015 MSC.Software Corporation

WS1 - 11

Create the finite element mesh.

a. Click Solid in the Meshers
group.

b. Select Hex for the Elem Shape,
IsoMesh for the Mesher, and
Hex8 for the Topology.

c. Enter 1.0 as the Global Edge
Length Value and uncheck
Automatic Calculation.

d. Click in the Solid List box.

e. Select the Solid in the view
port.

f. Click Apply.

Step 4. Apply IsoMesh with Hex8 Topology

f

c

b

d

e

a

Auto-Execute Option

The Auto-Execute option will
automatically apply the operation when
the last field is filled in. In this case, the
user can enter the number of elements for
the mesh seed and then select the edge.
Once the edge is selected, the operation
will be applied. There is no need to click
on the -Apply- button.
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Create the material property: steel

a. Under the Properties tab, click
Isotropic in the Isotropic
group.

b. Enter steel as the Material
Name.

c. Click Input Properties.

d. Enter 30e6 as the Elastic
Modulus.

e. Enter 0.30 as the Poisson
Ratio.

f. Enter 0.00074 as the Density.

g. Click OK.

h. Click Apply.

Step 5. Specify Material Properties

d

e

g

f

Make sure that after you
apply, steel appears in the

existing materials box

a

b

c

h
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Create the properties of the
beam.

a. Click Solid in the 3D
Properties group.

b. Enter beam as the
Property Set Name.

c. Confirm Homogeneous
/ Standard
Formulation for
Options.

d. Click on Input
Properties.

e. Click on the Mat Prop
Name icon.

f. Choose steel from the
Select Existing Material
list.

g. Click OK .

Step 6. Specify Solid Properties

b

c

d

e

g

f

a
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a. Click on Select Application
Region.

b. Select the Solid from the
viewport.

c. Click Add.

d. Click Ok.

e. Click Apply.

Step 6. Specify Solid Properties (Cont.)

a

c

b

e

d
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Fix the left side by creating a
displacement boundary.

a. Click Displacement
Constraint in the Nodal group.

b. Enter Fixed as the New Set
Name.

c. Click on Input Data.

d. Enter <0 0 0> for the
Translations.

e. Click OK.

Step 7. Create Displacement Constraint

d

e

b

c

a
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a. Click on Select Application
Region.

b. Verify Geometry is chosen for
Select.

c. Click in Select Geometry
Entities box.

d. Select Surface or Face in the
Picking Filters tool bar.

e. Select the Left edge of the
surface.

f. Click Add.

g. Click OK.

h. Click Apply.

Step 7. Create Displacement Constraint (Cont.)

h

a

g

c

b

f

d

e
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Create the load to be placed on
the right tip.

a. Click Force in the Nodal group.

b. Enter Tip_Load as the New
Set Name.

c. Click on Input Data.

d. Enter <0 -1500 0> for the
Force.

e. Click OK.

Step 8. Create and Apply Force

d

e

b

c

a
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a. Click on Select Application
Region.

b. Verify Geometry is chosen for
Select.

c. Click in Select Geometry
Entities box.

d. Select Point or Vertex in the
Picking Filters tool bar.

e. Select the Vertices on the Right
Edge by clicking each while
holding down the shift button.

f. Click Add.

g. Click OK.

h. Click Apply.

Step 8. Create and Apply Force (Cont.)

g

e

f

b

a

d

c

h
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Run a linear analysis.

a. Under the Analysis tab, click
Entire Model in the Analyze
group.

b. Enter Linear_Job1 as the Job
Name.

c. Click on Solution Type.

d. Verify Linear Static as the
Solution Type.

e. Click Solution Parameters

f. Click Results Output Format

g. Uncheck XDB

h. Check OP2

i. Click OK.

j. Click OK.

k. Click OK.

l. Click Apply.

Step 9. Analysis: Create Linear Static Job

a
d

e

c

b

f

gh

i

j

k

l
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Attach the results file, when the
analysis job is completed.

a. Under the Analysis tab, click
Attach Output2 in the Access
Results group.

b. Click Select Results File

c. Select linear_job1.op2.

d. Click on Apply.

Step 10. Analysis: Access Results

a

c

b

d
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Post-Process the linear job results.

a. Under the Results tab, click Fringe/Deformation in
the Quick Plot group.

b. Select Default A1: Static Subcase from the Select
Results Cases.

c. Select Displacements, Translational from the Select
Fringe Result.

d. Select Displacements, Translational from the Select
Deformation Result.

e. Click on Deform Attributes icon.

f. Select True Scale.

g. Click Apply.

h. Under the Home tab, click on the Front View icon

i. Click Fit View to get a view of the entire beam.

Step 11. Create Fringe Deformation Plot

f

g

h

a

i

b

c

d

e
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Step 11. Create Fringe Deformation Plot (Cont.)
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The maximum Y deflection of the beam can be taken directly off
of the displayed spectrum/range. The largest value should
correspond to a magnitude of 99.8, which is in fair agreement with
our hand calculation of 100. You may still improve this by
remeshing using a finer mesh. (You will be asked to do this after
you have run a nonlinear analysis of present mesh.)
Linear beam theory assumes plane section remain plane and the
deflection is small relative to length of the beam. As can be clearly
seen by this analysis, the deflection is very large and this analysis
is in violation of the underlying assumptions used for linear beam
theory.

These results match the linear hand calculations and also show
that the small deformation assumption is not valid and therefore, a
non-linear, large deformation analysis needs to be performed. In
large deformation analysis, the bending and axial stiffness are
coupled. Thus, as the cantilever beam deflects, a portion of the
applied load puts the beam in tension which tends to stiffen the
beam in bending (i.e. “geometric stiffness”). Thus, one would
expect to see a much smaller deformation in the large
deformation analysis as compared to the small deformation
analysis. To set up a large deformation analysis, one needs to
change the analysis set-up and re-submit the job to MSC Nastran.

Linear beam theory predicts the maximum beam
deflection in the Y-direction and stress to be:

After you apply your
graph should look

like this
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Run Nonlinear analysis.

a. Under the Analysis tab, click Entire Model in the Analyze
group.

b. Enter Nonlinear_Job2 as the Job Name.

c. Click Solution Type…

d. Select IMPLICIT NONLINEAR.

Step 12. Analysis: Create Implicit Nonlinear Job

d

a

b

c
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Run Nonlinear analysis.

a. Click Solution Parameters

b. Verify SOL 400 Run is checked

c. Verify Assumed Strain is
checked

d. Click on Results Output
Format.

e. Check op2.

f. Click OK.

g. Click OK.

h. Click OK.

Step 12. Analysis: Create Implicit Nonlinear Job
(Cont.)

b

c

e

f

The assumed strain
formulation improves the

bending behavior for
plane stress, plane strain

and solid elements
(CQUAD and CHEXA)

g a

d

h
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a. Click on Subcases.

b. Enter My_Nonlinear as the
Subcase Name.

c. Click on Subcase Parameters.

d. Confirm that Nonlinear
Geometric Effects is set to
Large Displacements/Large
Strains.

e. Click on Load Increment
Parameters.

f. Pull down Increment Type to
Adaptive.

g. Click OK.

h. Click OK.

i. Click Apply

j. Click Cancel

Step 12. Analysis: Create Implicit Nonlinear Job
(Cont.)

b

c

d

e

a

f

g

h

i j
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a. Click on Subcase Select.

b. Deselect the Default
subcase from Load Steps
Selected (by clicking on it)

c. Select My_Nonlinear from
the Existing Subcases.

d. Click OK.

e. Click Apply.

Step 12. Analysis: Create Implicit Nonlinear Job
(Cont.)

b

d

c

a

e
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Access the Results of the
nonlinear analysis.

a. Under the Analysis tab, click
Attach Output2 in the Access
Results group.

b. Click on Select Results File.

c. Select the file,
nonlinear_job2.op2.

d. Click OK.

e. Click on Apply.

Step 13. Analysis: Access Results

c

d

a

b

e
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Post-Process the nonlinear
results.

a. Under the Results tab click
Fringe/Deformation in the
Quick Plot group.

b. Click on the Select Results
icon.

c. Select the final non-linear
result case.

d. Select Displacements,
Translational from the
Select Fringe Result.

e. Select Y Component for
the Quantity.

f. Select Displacements,
Translational.

g. Click Apply.

Step 14. Results: Create Displacement Plot

a

b

c

d

e

f

g
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Step 15. Compare Your Results

● Finally get the maximum Y deflection from the fringe
spectrum/range. Enter that value into the first table below. Also
compare the quickplots obtained with both jobs.

MSC Nastran

Small Deflection Large Deflection

MSC Nastran

Theory -100.0 -58.59

Small Deflection Large Deflection

-99.80 -60.70

Compare with these
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As shown in the results obtained, inclusion of large
deformation effects are very important in realistically
modeling the physical behavior of the cantilever model.

Notice the horizontal displacement
in the nonlinear solution

Step 15. Compare Your Results (Cont.)

Nonlinear_job2Linear_job1
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• If you have time, do the following:

1. Detach both result files (use Analysis, Delete Results Attachment).

2. Delete the existing mesh.

3. Create a new finer mesh to compare with the results of the previous
analysis.

4. Since you applied the element properties and LBC’s to the geometry you
do not need to update or change them.

5. Run both linear and nonlinear jobs again.

Note: You might also want to try using the ‘Large Strain’ nonlinear formulation in the
Input Properties Form… this might be more important than refining the mesh. We
will cover this in the Nonlinear Elements Section.

Step 16. Try and Improve Your Results
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MSC Nastran

Small Deflection Large Deflection

Enter your new results

MSC Nastran

Theory -100.0 -58.59

Small Deflection Large Deflection

-99.80 -60.70

Compare with these results

6. Attach the result files and make quick plots as before. Compare
the Y-displacements with the ones obtained before and the
theoretical values (previous page). See if the results improved with
the finer mesh… it isn’t required that they do so, but is often
expected.

Step 16. Try and Improve Your Results (Cont.)
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WORKSHOP 2
RUBBER DOOR SEAL
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• Workshop Objectives

– Large displacement/ large strain analysis.

– Contact analysis using rigid-deformable contact.

– Hyperelastic material model.

• Software Version

– Patran 2013

– MSC Nastran 2013.1

• Required Files

– rubber_seal.ses

• Problem Description

– In this Exercise we analyze a trunk door seal. The purpose of the
analysis is to examine the stresses and deflections created during the
closing of a door. The seal is made of a rubber material and therefore
will be modeled using hyperelastic material properties. The trunk door is
considered very stiff relative to the rubber seal and can be modeled as a
rigid body.
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• Suggested Exercise Steps

1. Open a New Patran Database

2. Run the rubber_seal.ses

3. Mesh the top three surfaces using Isomesh and use Paver Mesher for the
Bottom Surface

4. Verify the Element for Cracks

5. Remove the Duplicate Nodes by Equivalence

6. Re-Verify the Element for Cracks

7. Align the Element Normals by Selecting any Element with a Positive Z-
Direction Normal

8. Fix the Bottom of the Seal by Applying a Displacement Constraint

9. Define the Deformable Contact Body for all Four Surfaces

10.Define the Rigid Contact Body for the Curves Representing the Door

11.Preview the Rigid Body Motion

12.Create Hyperelastic Material Properties

13.Apply 2D Solid Properties

14.Set up SOL400 Analysis

• Request OP2 Output

• Request Element Strains Output
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• Suggested Exercise Steps (Cont.)

15. Attach the OP2 File Attachment

16. Plot Results

• Plot Logarithmic Strains and Displacement Translation Results

• Plot Cauchy Stress and Displacement Translational Results

17. Quit Patran
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a

Open a new database named
door_seal.db:

a. Pull down File > New.

b. Type door_seal as File name.

c. Click OK.

d. Click OK to select
MSC.Nastran as the Analysis
Code.

Step 1: Open a New Database

b c
d
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When the session file is done the viewport will
contain all the geometry for the rubber seal and

trunk rigid body.

Run the provided session file.
a. Pull down File and select Session

and click Play.
b. Select rubber_seal.ses as the File

name.
c. Click Apply. (This action will run

the session file. Please do not
interrupt it.)

Step 2. Run the Provided Session File

a

b

c
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d

Continue working in Elements
form on the next page.

We use IsoMesh to mesh the top three surfaces since they
are simple (Green) surfaces.

a

b

f

e

Mesh the seal.
a. Under the Meshing

tab, click Surface in
the Meshers group.

b. Select IsoMesh as
the Mesher.

c. Pick all three (Green)
surfaces (Surface
1:3).To select
multiple surfaces,
hold the SHIFT key
down while picking.

d. Uncheck Automatic
Calculation.

e. Enter .015 as the
Value.

f. Click Apply.

Step 3. Create the Mesh

c
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c
d

a

We use Paver to mesh the bottom part
since it is a complex (Magenta) surface.

e

a. Select Paver as the
Mesher.

b. Select the bottom
(Magenta) surface
(Surface 4).

c. Uncheck Automatic
Calculation.

d. Enter 0.015 as the
Value.

e. Click Apply.

Step 3. Create the Mesh (Cont.)

b
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Verify the Element
Boundaries.

a. Click Verify in the
FEM Actions group

b. Click Apply.

c. When done, click
Reset Graphics.

Step 4. Verify the Element for Cracks

This option will show where there are
free element edges. Free element
edges are essentially ‘cracks’ in the
model where duplicate nodes exist.
Patran will not automatically remove
duplicate nodes when meshing
congruent surfaces like the ones in this
model. Step 5 will show the
Equivalence option to remove
duplicate nodes.

a

b

c

These lines show ‘cracks’ in the FE Model.
They need to be removed before the
Analysis can be performed.
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a

b

Equivalence the model.

a. Click Equivalence in the FEM Actions group.

b. Click Apply.

Step 5. Remove the Duplicate Nodes

Equivalence any duplicate nodes created during meshing.
This process will delete all the overlapped nodes (where

the pink circles are), and have only one node left.
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Re-Verify the Element Boundaries.

a. Click Verify in the FEM Actions group.

b. Click Apply.

c. Click Reset Graphics.

Step 6. Re-Verify the Element for Cracks

b

c

a

After the
Equivalence

Operation, the
‘cracks’ are now

gone.
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Verify the element normals.

a. Select Normals for Test.

b. Select Draw Normal Vectors.

c. Click Apply.

d. Under Home tab, Click Iso1
View in the Orientation group.

Step 7. Align the Element Normals

a

b

c

Since this is a 2-D solid model, all element
normals must point in the positive Z-direction.
Verify the element normals, and correct those
whose normals point in the wrong direction.

d

Wrong orientation.
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a. Click on Reverse
Elements.

b. Pick any element
pointing in the positive
Z-direction as the
guiding element.

c. Click Apply.

d. Click Reset Graphics.

e. Click the Front View
Icon.

Step 7. Align the Element Normals (Cont.)

a

c

d

e

After all operations, your model should look like
the image to the left

b
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Create the Boundary Condition
fixing the bottom of the rubber
seal.

a. Under the Loads/BCs tab click
Displacement Constraint in
the Nodal group.

b. Enter Fixed as the New Set
Name.

c. Click on Input Data.

d. Enter <0,0, > for the
Translation.

e. Click OK.

Step 8. Fix the Bottom of the Seal

a

b

c

d

e
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b

a

f

After the Fixed constraint is applied, the
model should look like the image to the
right.

a. Click on Select
Application Region.

b. Select the Curve or
Edge icon from the
Picking Filters tool bar.

c. Select the bottom curve
of the seal.

d. Click Add.

e. Click OK.

f. Click Apply.

Step 8. Fix the Bottom of the Seal (Cont.)

c

d

e
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After you click Apply, you will
see the contact markers (pink
circles) in viewport.

Create the deformable contact
body.

a. Click Deformable in the
Contact Bodies group

b. Enter Seal as the New Set
Name.

c. Select 2D as the Target
Element Type.

d. Click on Select
Application Region form.

e. Select all four surfaces. To
select multiple surfaces,
hold the SHIFT key down
while picking.

f. Click Add.

g. Click OK.

h. Click Apply.

Step 9. Define the Deformable Contact Body

b

c

d

h

e

g

f

a
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Create the rigid contact body.

a. Under the Loads/BCs tab, click
Rigid in the Contact Bodies group.

b. Verify Rigid Body is set for
Option.

c. Enter Door as the New Set Name.

d. Select 1D as the Target Element
Type.

e. Click on Input Data.

f. Check Flip Contact Side (Flipping
the Contact Side is needed,
because of the orientations of the
curves representing the door)

g. Enter <-0.1, -0.7, 0.> for the
Velocity.

h. Click OK.

Step 10. Define the Rigid Contact Body

b

c

d

e

f

g

h

a
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a. Click Select Application Region.

b. Select all three curves defining the
rigid surface (Curve 2:4). To select
multiple surfaces, hold the SHIFT
key down while picking.

c. Click Add.

d. Click OK.

e. Click Apply.

Step 10. Define the Rigid Contact Body (Cont.)

Curve 3
Curve 4

Curve 2

b

e

c

d

a
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The rigid contact
markers point toward
the inside of the rigid
body. Think of them

as tick marks
representing a wall. If

the tick marks are
reversed, Modify the
Contact Body and flip
the contact side on

the Modify Data
Form.

You should now see the contact (pink) markers in the viewport and the name of
the object in the Existing Sets panel.

a

Step 10. Define the Rigid Contact Body (Cont.)
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Preview the Rigid Body
Motion.

a. Click Preview Motion.

b. Select Door.

c. Click Preview Motion.

d. The Rigid Body should
display the prescribed
motion that was entered
on the Input Data form.

e. Click OK when finished
examining the motion.

Step 11. Preview the Rigid Body Motion

a

d

c

b

e
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To create an isotropic Mooney-
Rivlin material:

a. Under the Properties tab, click
Isotropic.

b. Enter rubber for Material
Name.

c. Click Input Properties.

d. Hyperelastic > Nearly
Incompressible > Coefficients >
Mooney Rivlin MATHP > 1.

e. Enter 80 for Distortional Def.
Coef. A10.

f. Enter 20 for Distortional Def.
Coef. A01.

g. Enter 100000 for Vol.
Deformation Coef. D1.

h. Click OK.

i. Click Apply.

Step 12: Create Material

e

g

d

f

h

a

b

c

i
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To apply properties:

a. Click 2D Solid in the
2D Properties group.

b. Enter seal for Property
Set Name.

c. Change Options to
Hyperelastic
Formulation.

d. Click Input
Properties….

e. Click the Mat Prop
Name Icon.

f. Select rubber.

g. Click OK.

Step 13: Apply Properties

c

b

d

f
e

g

a
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To apply properties:

a. Click Select Application Region.

b. Click in the Select Members text box.

c. Select all the surfaces.

d. Click Add.

e. Click Ok.

f. Click Apply.

Step 13: Apply Properties (Cont.)

a

f
c

b

d

e
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Set up the non-linear
Analysis job.

a. Under the Analysis tab,
click Entire Model in
the Analyze group.

b. Enter door_seal as the
Job Name.

c. Open Solution Type.

d. Select Implicit
Nonlinear as Solution
Type.

e. Click on Solution
Parameters…

f. Confirm SOL400 Run,
and uncheck Assumed
Strain.

g. Click Results Output
Format.

Step 14. Set up Analysis

f

g

f

a

b

c

d

e
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a b

c d e

a. Check OP2.

b. Check Print.

c. Click OK.

d. Click OK.

e. Click OK.

Step 14. Set up Analysis (Cont.)
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b

c

d

e

f

g

h

a. Click on Subcases.

b. Click on Default under Available
Subcases.

c. Click on Subcase Parameters.

d. Verify Large Displacement/Large Strains
is chosen under Nonlinear Geometric
Effects.

e. Click on Load Increment Parameters.

f. Pull down Adaptive for Increment type.

g. Click OK.

h. Click Iteration Parameters.

Step 14. Set up Analysis (Cont.)

a
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c
d

a

b

a. Select Pure Full Newton as
Matrix Update Method.

b. Enter 4 as Max # of Bisections.

c. Click OK.

d. Click OK.

Step 14. Set up Analysis (Cont.)
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a

c

a. Click Output Requests.

b. Select Element Strains.

c. Click OK.

Step 14. Set up Analysis (Cont.)

b
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a b

a. Click Apply.

b. Click Cancel.

c. Click Apply.

Step 14. Set up Analysis (Cont.)

c
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c

d

Read (Attach) results.

a. Under the Analysis tab, click
Attach Output2 in the Access
Results group.

b. Click Select Results File...

c. Select door_seal.op2.

d. Click OK.

e. Click Apply.

Step 15: Access the Nonlinear Results

a

e

b
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To create a fringe results plot:

a. Under the Results tab, click
Fringe/Deformation in the
Quick Plot group.

b. Select the last result case.

c. Select Logarithmic Strains,
as the Fringe Result.

d. Select Displacements,
Translational.

e. Click the Deform Attributes
icon.

f. Change the Scale
Interpretation to True Scale.

g. Click Apply.

Step 16: View Results

f

g

a

e

b

c

d
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Step 16: View Results (Cont.)
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a

a. Click the Select Results icon

b. Select Cauchy Stresses as
the Fringe Result

c. Click Apply.

Step 16: View Results (Cont.)

b

c
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Step 16: View Results (Cont.)
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Step 17. Quit Patran
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WORKSHOP 3

DEFORMABLE TO RIGID CONTACT
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• Workshop Objectives

– To perform a start to finish contact analysis with MSC Nastran that uses
both deformable and rigid contact bodies

– To gain experience in the definition of the motion of rigid contact bodies

– To gain familiarity with the Patran contact analysis GUI

• Software Version

– MSC Nastran 2013.1

– Patran 2013

• Required Files

– latch.db
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• Problem Statement

– This problem will simulate the closing of a latch mechanism and will include
a spring clip that is compressed by moving surfaces of the closing door
mechanism

– Because of the high relative flexibility of the spring when compared to the
door, the door surfaces will be represented with rigid contact bodies

Spring
Clip

Mechanism surface 2 shown in its original
location – rotates about its left edge .5
radians.

Mechanism surface 2
shown in its rotated state

Mechanism surface 1 –
moves laterally -0.3mm
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• Suggested Steps

1. Open the database latch.db

2. Create a deformable contact body for the spring clip

3. Create rigid contact bodies for the 2 rigid surfaces including prescribed
motions

4. Create contact pairs between the clip and the rigid bodies

5. Fix the spring clip around the rectangular hole

6. Set up and run the analysis.

• Set Solution Type to SOL400 – implicit nonlinear

• Request OP2 for Results Output Format.

• Request contact results output

• Run the analysis

7. Review the MSC Nastran f06 file for errors.

8. Correct the normal direction of contact

9. Attach the OP2 results file

10.Plot deformation and von Mises stress results

11.Make a Marker Plot of Contact Status

12.Plot Normal Contact Force as a Vector Plot

13.Display a Fringe Plot of Contact Status

14.Display a Fringe Plot of Normal Contact Stress
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Open the database latch.db:

a. Pull down File > Open.

b. Select latch.db as the database file.

c. Click OK.

Step 1. Open the Existing Database

a

b

c
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Create a deformable contact body
for the spring clip:

a. Under the Loads/BCs tab, click
Deformable in the Contact
Bodies group.

b. Enter clip for New Set Name.

c. Pull down Target Element Type
to 2D.

d. Click Select Application
Region.

e. Click Pick All to select all the
surfaces.

f. Click Add.

g. Select the two mechanism
surfaces: Surfaces 20 and 21.

h. Click Remove.

i. Click OK.

j. Click Apply.

Step 2. Create Deformable Body

b

c

d

e
f h

i j

g

a
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a

Step 3. Create Two Rigid Contact Bodies

e

f

i

j

b

c
g

k

Create rigid contact bodies for the 2 mechanism
surfaces including prescribed motions from the
Problem Description:

a. Click Rigid in the Contact Bodies group.

b. Enter side for New Set Name.

c. Click Input Data.

d. Pull down Motion Control to Force/Moment

e. Select Node on Corner of Side Surface

f. Click OK.

g. Click Select Application Region.

h. Select the side surface.

i. Click Add.

j. Click OK.

k. Click Apply.

d

h

Note the direction of
the normal vectors
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Create the rigid contact bodies (cont.):

a. Enter bottom for New Set Name.

b. Click Input Data.

c. Pull down Motion Control to Position

d. Enter <0, 0, 0> for Displacement(vector).

e. Enter 0.5 for Angular Position.

f. Select Node 9999 on the corner of the
bottom surface for the Rotation Reference
Point.

g. Enter <0 0 1> for the Axis of Rotation.

h. Click OK.

i. Click Select Application Region.

j. Select the bottom surface.

k. Click Add.

l. Click OK.

m. Click Apply.

Step 3. Create Two Rigid Contact Bodies (Cont.)

d

a

b

c

e

f

i
g

j

h

k

l

e

Note the
direction of the
normal vectors



NAS400, Workshop 3, January 2015
Copyright© 2015 MSC.Software Corporation

WS3 - 10

Create contact pairs between the
clip and rigid bodies:

a. Click Create Body Pair in the
Body Pairs group.

b. Enter side_contact for New
Set Name.

c. Click Select Application
Region.

d. Select the side contact body
for Body1/Master/Touched.

e. Select the clip contact body for
Body2/Slave/Touching.

f. Click OK.

g. Click Apply.

Step 4. Create Contact Pairs

b

c

d

e

f

g

a
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Create the contact pairs between
the clip and rigid bodies (cont.):

a. Enter bottom_contact for New
Set Name.

b. Click Select Application
Region.

c. Select the bottom contact body
for Body1/Master/Touched.

d. Select the clip contact body for
Body2/Slave/Touching.

e. Click OK.

f. Click Apply.

Step 4. Create Contact Pairs (Cont.)

a

b

c

d

e

f
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Fix the spring clip around the
rectangular hole:

a. Click Displacement Constraint
in the Nodal group.

b. Enter hold for New Set Name.

c. Click Input Data.

d. Enter <0, 0, 0> for Translations.

e. Enter <0, 0, 0> for Rotations.

f. Click OK.

g. Click Select Application
Region.

h. Click Curve or Edge on the
Picking Filters Toolbar.

i. Select the surface edges that
bound the hole.

j. Click Add.

k. Click OK.

l. Click Apply.

Step 5. Apply Loads and Boundary Conditions

b

c

d

e

f

g

h

i

j

k

l

a
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Apply Node Force <-1,0,0> to the
Control Node of the Side Surface

a. Pull down Object > Force

b. Enter Name Side_force

c. Click Input Data

d. Enter <-1,0,0> for Force

e. Click OK

f. Click Select Application
Region…

g. Pull down Select to FEM

h. Select Control Node of Side

i. Click Add

j. Click OK

k. Click Apply

Step 5. Apply Loads & BCs (Cont.)

a

b

c

d

e

f

h

g

i

j

k
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Set Solution Type to SOL400:

a. Under the Analysis tab, click
Entire Model in the Analyze
group.

b. Click Solution Type….

c. Select Implicit Nonlinear for
Solution Type.

d. Click Solution Parameters.

Select the Results Output Format and
run the analysis:

e. Click Results Output Format.

f. Check OP2 and Print

g. Close all sub-menus by clicking
OK .

Step 6. Set Up and Run the Analysis

e

b

c

d

a

g

g
f

g

f
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Request contact results output:

a. Click Subcases…

b. Click on Default under
Available Subcases.

c. Click Output Requests.

d. Select Contact Results.

e. Click OK.

f. Click Apply.

g. Click Cancel.

To run the analysis:

h. Click Apply.

Step 6. Set Up and Run the Analysis (Cont.)

c

b

d

e f g

a

h
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Review the MSC Nastran f06 file
for errors:

a. In the training directory locate
and open the file latch.f06 with
any text editor.

b. Search on the string FATAL
and note the messages

Step 7. Review the MSC Nastran f06 File

*** USER INFORMATION MESSAGE 6193 (nl3con)
*** MAXIMUM NUMBER OF BISECTIONS OR MINIMUM TIME STEP HAS BEEN REACHED ***

*** JOB DOES NOT CONVERGE AT THE CURRENT TIME STEP OR INCREMENT.
*** SOLUTION DIVERGES FOR SUBCASE 1 STEP 1.

^^^
*** USER FATAL MESSAGE 9032 (SUBDMAP NONLIN)

RUN IS TERMINATED DUE TO MESSAGE(S) ABOVE

a

b

An error is encountered due
to the direction of contact for

the ‘side’ contact body.
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a

Reverse the contact side for the
‘side’ rigid body:

a. Under the Loads/BCs tab, click
Rigid in the Contact Bodies
group.

b. Pull down Action to Modify.
Pull down Object to Contact

c. Select the side contact body.

d. Click Modify Data.

e. Check Flip Contact Side.

f. Click OK.

g. Click Apply.

Step 8. Correct the Direction of Contact

b

c

d

e

f g

Re-run the analysis (Repeat Step 6).

Note the
normal vectors
now point
away from the
clip
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Attach the Master result file:

a. Under the Analysis tab, click
Attach Output2 in the Access
Results group.

b. Click Select Results File…

c. Select the latch.op2 result file.

d. Click OK.

e. Click Apply.

Step 9. Attach .op2 Result File

a

c

d

b

e
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Plot deformation and von Mises stress:

a. Under the Results tab click
Fringe/Deformation in the Quick Plot
group.

b. Select SC1:…A1:Time = 1.0 for Select
Result Cases.

c. Select Nonlinear Stresses, Stress Tensor
for Select Fringe Result.

d. Select Displacements, Translational for
Select Deformation Result.

e. Click the Deform Attributes icon

f. Select True Scale and Uncheck Show
Undeformed

g. Click Apply.

h. When finished,
click Reset Graphics.

Step 10. Plot the Deformation and Stress
Results

a

f

g

h

b

c

d

e

f
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Create a Marker Plot of the Contact status:

a. Pull down Create > Marker > Scalar.

b. Select SC1:…A1:Time = 1.0 for Select Result Cases.

c. Select Contact Status for the Scalar Result.

d. Click the Display Attributes icon.

e. Pull down Scalar Style and pick the Solid Sphere.

f. Click Apply.

g. The solid sphere markers appear on the clip as shown.

h. When finished, click Reset Graphics.

Step 11. Creating Marker Plot of Contact Status

a

c

d

e

f

g

h

b
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Plot the Normal Contact Force Vector
for the clip:

a. Pull down Vector for Method

b. For the Vector Result select
Contact Force, Normal.

c. Pull down Resultant for Show As.

d. Click Apply.

e. The Normal Force Vectors will
appear on the clip as shown.

f. When finished, click Reset
Graphics.

Step 12. Plot Normal Contact Force

b

c

d

a

e

f
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Display a Fringe Plot of the
Contact status for the clip:

a. Pull down Object to Fringe.

b. For the Fringe Result select
Contact Status.

c. Click Apply.

d. The fringe plot will appear on
the clip as shown.

e. When finished, click Reset
Graphics.

Step 13. Display a Fringe Plot of Contact Status

e

a

b

c

d
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Display a fringe plot of Normal Contact Stress on the clip:

a. For the Fringe Result select Contact Stress, Normal.

b. Click Apply.

c. The normal stress fringe plot will appear on the clip as
shown.

Step 14. Display a Fringe Plot of Normal Contact
Stress

c

a

b
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WORKSHOP 4

INTERFERENCE FIT
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• Workshop Objectives:

– Perform interference fit analysis using deformable-deformable contact

– Modify contact table parameters

– Understand the two methods of modeling interference fit

– Switch between Node to Segment and Segment to Segment contact

• Software Version:

– Patran 2013

– MSC Nastran 2013.1

• Files Required:

– interference_fit.igs

• Problem Description

– Two types of interference fit modeling are demonstrated in this workshop.
The interference can be modeled geometrically, or you can use congruent
geometry and specify an Interference Closure in the contact table. This
workshop will show that the same results are achieved for both methods.
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• Suggested Exercise Steps

1. Create a new database called Interference_Fit.

2. Import the Geometry interference_fit.igs.

• Uncheck Import to Parasolid.

3. Create a 0.1 inch Mesh with 8 noded quads.

4. Fix the left edge of the lug in the X and Y direction.

5. Define deformable contact bodies for the lug, upper pin, and lower pin with
friction coefficients of 0.3.

6. Define Contact pairs

• Turn off all self-contact and contact between the Upper and Lower Pin.

• Create a Distance Tolerance of 0.015 between the Lug and Lower Pin.

• Create an Interference Closure of 0.01 between the Lug and Upper Pin.

7. Define material properties for steel with an elastic modulus of 30E6 and a
Poisson’s ratio of 0.3.

8. Define plane strain element properties.

• Select Large Strain for Nonlinear Formulation (SOL400)
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• Suggested Exercise Steps (Cont.)

9. Set up and submit an implicit nonlinear analysis.

• Do not use Assumed Strain.

• Define Contact Parameters

– Distance Tolerance (ERROR) of 0.015.

– Activate quadratic contact (LINQUAD).

– Friction type is bilinear coulomb.

• Use OP2 for the results output format.

• Define Subcase Parameters

– Use Adaptive Increment Type and Trial Time Step Size = 0.1.

– Use Pure Full Newton for the Matrix Update Method.

• Select to Output Element Strain and Contact results.

10.Attach the .op2 Results File.

11. Plot the Cauchy Stress Fringe Results superimposed on the true scale
deformed shape for the final load increment.

12. Plot Contact Status and Contact Force results.
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• Suggested Exercise Steps (Cont.)

13.Run the analysis again using Segment to Segment contact in place of
Node to Segment contact

14.Attach the Segment to Segment .op2 Result file

15.Plot the Cauchy Stress Fringe Results superimposed on the true scale
deformed shape.

16. Plot Contact Status and Contact Force results for Segment to Segment
Contact

17.Quit Patran.
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Create a new database. Name it
Interference_Fit.db.

a. Pull down File > New.
b. Enter Interference_Fit as the

File name.
c. Click OK.
d. Confirm MSC Nastran as the

Analysis Code.
e. Click OK.

Step 1. Create a New Database

a

b c

d

e
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Import the geometry.

a. Pull down File > Import.
b. Pull down Source to IGES.
c. Uncheck Import to Parasolid.
d. Navigate to and select

interference_fit.igs.
e. Click Apply.

Step 2. Import the Geometry

b

c

d

e

a
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a. The IGES Import Summary form
shows the types and numbers of
entities imported into the Patran
database. Click OK.

Step 2. Import the Geometry (Cont.)

a

The imported geometry consists of 3 surfaces:
one large lug with 2 pins. The lower pin has an

interference of 0.01 inches built into the
geometry. The upper pin geometry is congruent

with the Lug geometry. The interference fit in
this case will be created by the Interference
Closure contact parameter which will force a

gap between the two bodies.
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a

Create a 0.1 inch Mesh with
8 noded quads.

a. Under the Meshing tab,
click Surface in the
Meshers group.

b. Pull down Paver for
Mesher.

c. Pull down Quad8 for
Topology. Quad8
elements are higher-
order elements with mid-
side nodes.

d. Click Pick All on the
Picking Filters toolbar to
select all three Surfaces.

e. Uncheck Automatic
Calculation.

f. Enter 0.1 for the Global
Edge Length Value.

g. Click Apply.

Step 3. Create the Elements

c
b

e
f

g

d
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Fix the left edge of the lug in the
X and Y direction.

a. Under the Loads/BCs tab, click
Displacement Constraint in
the Nodal group.

b. Enter Fixed as the New Set
Name.

c. Click Input Data.
d. Enter <0,0, > for the

Translations.
e. Click OK.

Step 4. Fix the Left Edge of the Lug

b

c

d

e

a
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c

e

a

d

f

a. Click Select Application
Region.

b. Confirm the Select filter is set to
Geometry.

c. Click Curve or Edge on the
Picking Filters toolbar.

d. Select the left edge of the lug.
e. Click Add.
f. Click OK.
g. Click Apply.

Step 4. Fix the Left Edge of the Lug (Cont.)

b

g
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Create three deformable contact bodies
.
a. Pull down Tools > Modeling and

select Contact Bodies/Pairs…
b. Pull down Method to Geometry
c. Select Surface under Geometry
d. Click Apply
e. Click Cancel

Step 5. Define the Deformable Contact Bodies

b

c

d e
After you click Apply, you will

see the contact markers
(magenta circles) in the viewport.

a
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Rename the deformable
contact bodies:

a. Under the Home tab click
Model Tree

b. Right-click on
Surface_bdy1 under
ContactDeformable
Body group in the Model
Browser and select
Modify.

c. Enter 0.3 for the Friction
Coefficient.

d. Click OK.
e. Enter Lug for the Rename

Set as.
f. Click Apply.

Step 5. Define the Deformable Contact Bodies
(Cont.)

c

fd

e

a

b
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Rename the deformable contact
bodies (cont.):

a. Click Surface_bdy2 under
Select Set to Modify.

b. Enter Upper_Pin for the
Rename Set as.

c. Click Modify Data
d. Enter 0.3 for the Friction

Coefficient.
e. Click OK.
f. Click Apply.
g. Click Surface_bdy3 under

Select Set to Modify.
h. Enter Lower_Pin for the

Rename Set as.
i. Click Modify Data
j. Enter 0.3 for the Friction

Coefficient.
k. Click OK.
l. Click Apply.

Step 5. Define the Deformable Contact Bodies
(Cont.)

a

b

c

f

d

e

h

g

i

j

k l
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Create Contact Pair between
Lower pin and the Lug:

a. Under the Loads/BCs tab
click Create Body Pair in
the Body Pairs group

b. Enter Lug_Lower_Pair for
New Set Name

c. Click Input Data.
d. Enter 0.015 for the

Distance Tolerance
e. Click OK
f. Click Select Application

Region
g. Click Select Existing

Touched Body icon near
Body1/Master/Touched
and select Lug

h. Click Select Existing
Touching Body icon near
Body2/Slave/Touching and
select Lower_Pin

i. Click OK
j. Click Apply

Step 6. Create Contact Pairs

a

b

c

d

e
f

g

h

j

i
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Create Contact Pair between
Lug and the Upper Pin:

a. Enter Lug_Upper_Pair for
New Set Name

b. Click Input Data.
c. Enter Lug_Upper_Pair_g

for Property Set Name.
d. Enter 0 for the Distance

Tolerance
e. Enter 0.01 for the

Interference Closure
f. Click OK
g. Click Select Application

Region
h. Click Select Existing

Touched Body icon near
Body1/Master/Touched and
select Upper_Pin

i. Click Select Existing
Touching Body icon near
Body2/Slave/Touching and
select Lug

j. Click OK
k. Click Apply

Step 6. Create Contact Pairs (Cont.)

b

c

d

e

f

g

i

k

h

a
j
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Define material properties for steel with
an elastic modulus of 30E6 and a
Poisson’s ratio of 0.3 :

a. Under the Properties tab, click
Isotropic in the Isotropic group.

b. Enter Steel for the Material Name.
c. Click Input Properties.
d. Confirm Linear Elastic is selected

for the Constitutive Model.
e. Enter 30e6 for the Elastic Modulus.
f. Enter 0.3 for the Poisson Ratio.
g. Click OK.
h. Click Apply.

Step 7. Define the Material Properties

d

e
f

g

b

c

h

a
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Define Plane Strain element
properties:

a. Click 2D Solid in the 2D
Properties group.

b. Enter Steel for the Property
Set Name.

c. Confirm that Plane Strain and
Standard Formulation are
selected under Options.

d. Click Input Properties.
e. Click the Mat Prop Name icon.
f. Choose Steel from the

Existing Material list.
g. Pull down Large Strain for

Nonlinear Formulation
(SOL400).

h. Click OK.

Step 8. Define the Element Properties

b

c

d

f

a

g

e

h
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a
b

c

a. Click Select Application
Region.

b. Drag a rectangle to select all
three Surfaces.

c. Click Add.
d. Click OK
e. Click Apply

Step 8. Define the Element Properties (Cont.)

d

e
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Set up the Analysis:

a. Under the Analysis tab, click
Entire Model in the Analyze
group.

b. Enter Interference_Fit as the
Job Name.

c. Click Solution Type.
d. Select Implicit Nonlinear for

Solution Type.
e. Click Solution Parameters.
f. Uncheck Assumed Strain
g. Click Results Output Format…
h. Uncheck MASTER/DBALL.
i. Select OP2
j. Click OK

Step 9. Set up and Submit the Analysis

f
b

c

d

e

a

h

g

i

j
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k

Define Contact Parameters:

a. Click Contact Parameters.
b. Click Contact Detection.
c. Enter 0.015 for Distance

Tolerance (ERROR).
d. Check Activate Quadratic

Contact (LINQUAD). Uncheck
Permanent Gluing

e. Click OK.
f. Click Friction.
g. Pull down Bilinear Coulomb

for Type.
h. Click OK.
i. Click OK.
j. Click OK.
k. Click OK.

Step 9. Set up and Submit the Analysis (Cont.)

a

g

h

c

d

e

b

f

i

j

d
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b

c

d

e

a

Define Subcase Parameters:

a. Click Subcases.
b. Click Default under Available Subcases.
c. Click Subcase Parameters.
d. Confirm Large Displacement/Large Strains is

selected for Nonlinear Geometric Effects.
e. Click Load Increment Parameters.

Step 9. Set up and Submit the Analysis (Cont.)
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d

a

b

c

Set Increment Type to Adaptive
and Trial Time Step Size = 0.1 :

a. Pull down Increment Type to
Adaptive.

b. Enter 0.1 for Trial Time Step
Size.

c. Click OK.
d. Click Iteration Parameters.

Step 9. Set up and Submit the Analysis (Cont.)
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c

Select Pure Full Newton for the Matrix Update Method
a. Pull down Pure Full Newton for the Matrix Update

Method.
b. Click OK.
c. Click OK on the Static Solution Parameters form.
d. Click Output Requests.

Step 9. Set up and Submit the Analysis (Cont.)

a

b

d
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c d

a

b

Select to Output Element Strain
and Contact results (cont.):

a. Select Element Strains and
Contact Results.

b. Click OK.
c. Click Apply.
d. Click Cancel.
e. Click Apply.

Step 9. Set up and Submit the Analysis (Cont.)

e
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Attach the .OP2 Results file.
a. Click Attach Output2 in the

Access Results group.
b. Click Select Results File…
c. Select interference_fit.op2
d. Click OK.
e. Click Apply.

Step 10. Attach the .op2 Results File

a

c

d

b

e
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Plot the Cauchy Stress Fringe
Results superimposed on the true
scale deformed shape for the final
load increment.
a. Under the Results tab, click

Fringe/Deformation in the
Quick Plot group.

b. Select the final result case.
c. Select Cauchy Stresses for

Fringe Result.
d. Select Displacements,

Translational for Deformation
Result.

e. Click Deform Attributes.
f. Select True Scale.
g. Uncheck Show Undeformed.
h. Click Fringe Attributes.
i. Pull down Element Edges for

Display.
j. Select Black for Fringe Edges.
k. Click Apply.

Step 11. View Deformation and Stress Results

a

g

h

f

k

i
j

b

e

c

d
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Step 11. View Deformation and Stress Results
(Cont.)
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Plot Contact Status results.
a. Click Reset Graphics to

clear the current results plot.
b. Click Fringe in the Result

Plots group.
c. Select the final result case.
d. Select Contact Status

under Select Fringe Result.
e. Click Apply.
f. Note the range from 0 to 1.

Zero indicating the master
body and 1, the slave body.

Step 12. View Contact Results

b

a

f

c

d

e
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Plot contact friction force.
a. Select contact force, Friction

under Select Fringe Result.
b. Click Apply.

Step 12. View Contact Results (Cont.)

a

b
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Plot contact normal force.
a. Select contact force, Normal

under Select Fringe Result.
b. Click Apply.

Step 12. View Contact Results (Cont.)

a

b
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Run the Analysis using Segment to
Segment contact in place of Node
to Segment contact.
a. Under the Analysis tab, click

Entire Model in the Analyze
group.

b. Select Interference_Fit from
the list of Available Jobs.

c. Change the Job Name to
Interference_Fit_sts.

d. Click Solution Type…
e. Click Solution Parameters…
f. Click Contact Parameters…

Step 13. Run Analysis with Segment to Segment

a

b

c

d
e

f
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Run the Analysis using Segment
to Segment contact in place of
Node to Segment contact.
a. Pull down Control Method to

Segment to Segment.
b. Click Friction
c. Pull down Type to Coulomb
d. Click OK
e. Click Augmentation…
f. Pull down Augmentation

Method to Bilinear.
g. Click OK on all forms.
h. Click Apply.

Step 13. Run Analysis with Segment to Segment
(Cont.)

a

b

c

d

e

d

h

h

f

g

g
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Attach the Segment to
Segment .op2 Result file
a. Click AttachOutput2 in the

Access Results group.
b. Click Select Results File…
c. Select

interference_fit_sts.op2.
d. Click OK.
e. Click Apply.

Step 14. Attach Segment to Segment Result File

a

c

d

b

e
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Plot the Cauchy Stress Fringe Results
superimposed on the true scale deformed
shape.
a. Under the Results tab, click

Fringe/Deformation in the Quick Plot
group.

b. Select the final result case.
c. Select Cauchy Stresses for Fringe

Result.
d. Select Displacements, Translational

for Deformation Result.
e. Click Deform Attributes.
f. Select True Scale.
g. Uncheck Show Undeformed.
h. Click Fringe Attributes.
i. Pull down Element Edges for Display.
j. Select Black for Fringe Edges.
k. Click Apply.

Step 15. View Segment to Segment Results

a

g

h

f

k

i
j

e

b

c

d
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Step 15. View Segment to Segment Results
(Cont.)
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Plot Contact Status results.
a. Click Reset Graphics to

clear the current results
plot.

b. Click Fringe in the Result
Plots group.

c. Select the final result
case.

d. Select Contact Status
under Select Fringe
Result.

e. Click Apply.
f. Note the range is now

uniformly 1. For segment
to segment contact, there
is no slave and master
relationship.

Step 16. View Segment to Segment Contact
Results

b

c

d

e

a

f
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Plot contact friction force.
a. Select contact force, Friction under

Select Fringe Result.
b. Click Apply.

Step 16. View Segment to Segment Contact
Results (Cont.)

a

b
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Plot contact normal force.
a. Select contact force, Normal

under Select Fringe Result.
b. Click Apply.

Step 16. View Segment to Segment Contact
Results (Cont.)

a

b
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Step 17. Quit Patran
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WORKSHOP 5
CONTACT PAIRS
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• Objective

– Include a fine mesh locally in a coarser-meshed model.

– Use Patran’s Automatic Contact Body and Body Pair detection to detect
and create multiple contact bodies.

– Use the Distance Tolerance (ERROR) to achieve glued contact between
bodies with gaps.

• Files Required

– wingskin_fe.bdf

• Software Version

– MSC Nastran 2013.1

– Patran 2013
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• Suggested Steps:

1. Create a new Patran database.

2. Import the MSC Nastran input file, wingskin_fe.bdf.

3. Define Contact Bodies using Patran’s auto detect tool.

4. Define Contact Pairs.

• Contact Pair between the Panels with tolerance of 0.003 and glued contact.

• Contact Pair between the Rib and panels with tolerance of 0.02 and glued
contact.

5. Modify the Load Case

6. Verify the Boundary Conditions.

7. Set up an implicit Nonlinear analysis (SOL400) with contact results. Run
the analysis.

8. Attach the OP2 results.

9. Review the deformed shape.

10.Verify contact status.
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a

Create a new database. Name it
window_detail.db

a. Pull down File > New.

b. Enter window_detail as the
File name.

c. Click OK.

d. Pull down MSC.Nastran as the
Analysis Code.

e. Pull down Structural as
Analysis Type.

f. Click OK.

Step 1. Create a New Database

b c

d

e

f
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Import the MSC Nastran Input file,
wingskin_fe.bdf.

a. Pull down File > Import.

b. Pull down MSC.Nastran Input
for Source.

c. Select wingskin_fe.bdf

d. Click Apply.

e. Review the Import Summary
and click OK.

Step 2. Import the Model

a bc

d

e
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a. Click Iso 1 View in the
Orientation group.

b. Click Fit View in the Viewport
group.

c. Click Smooth Shaded in the
Display group.

Step 2. Import the Model (Cont.)

acb

NOTE: Notice that here we
have an airframe model that
has a very fine mesh in the
window and some of its
panels. Other panels have a
comparatively coarser mesh.
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Define Contact bodies using the
Create Contact Body/Pairs tool.

a. Pull down Tools > Modeling >
Contact Bodies/Pairs.

b. Pull down Method to
Connectivity.

c. Check 2D for Elements.

d. Click Apply.

e. Under the Loads/BCs tab, click
Color Code Bodies in the
Contact Bodies group.

f. Highlight all sets under Existing
Sets.

g. Select Group Color.

h. Click Apply.

Step 3. Define Contact Bodies

g

b

d

e

a

All Contact bodies will be
detected and generated with
one click. As an alternative to
the Connectivity Method, you
can use Properties and
Contact bodies will be
generated based on their
associated Properties and
named accordingly.

f

h

c
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Contact Bodies Defined

Return to the Home tab and
click Smooth Shaded in the
Display group. You can modify
the lightening on the view by
Pulling down Display > Light
Sources, select more Light
Sources and click Apply.
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Define Contact Pairs using Create Contact Body/Pair
tool.

a. Pull down Create to Body Pair.

b. Select Select Bodies on the Create Contact
Bodies/Pairs form.

c. Click the Select Existing Bodies icon.

d. Highlight all Sets under Existing Bodies, except
2D_bdy5 and 2D_bdy6 (the ribs).

e. Select Specify in the Contact Properties Set group

f. Enter Panel_prop for Geometric Property.

g. Enter Panel_phy_prop forPhysical Property.

h. Click Apply.

i. Click OK to close the Auto Creation Summary form.

Step 4. Define Contact Pairs (Cont.)

a

b c

d

e
f

g

h
i

If you closed the Create
Contact Body/pair tool
earlier, you can reopen
it by pulling down Tools
> Modeling > Contact

Bodies/Pairs…
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Define the contact pair between
the rib and all the panels.

a. Enter 0.008 for Distance
Tolerance. This is a gap
between the rib and panels.

b. Select Entire Model in Create
From.

c. Enter Rib_prop for Geometric
Property.

d. Enter Rib_phy_prop for
Physical Property.

e. Click Apply.

f. Click No on all the Messages
for duplicate pairs.

g. Click OK.

h. Click Cancel.

Step 4. Define Contact Pairs (Cont.)

a

b

c

d

e

f

g
h
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Modify the contact pair parameters.

a. Click Create Body Pair

b. Pull down Action to Modify.

c. Pull down Object to Contact.

d. Pull down Option to Body Pair.

e. Highlight 2D_bdy1_2D_bd3_pair.

f. Click Modify Data…

g. Enter 0.003 for Distance
Tolerance(ERROR)

h. Check Glued Contact, Retain
Gaps/Overlaps, and Retain
Moment.

i. Check Stress Free InitCont.

j. Select Automatic under Contact
Detection.

k. Click Contact Option.

l. Check Ignore Thickness for both
Bodies.

m. Click OK.

n. Click Apply.

Step 4. Define Contact Pairs (Cont.)
a

b

c

d

e

f

g

h

i

k

j

m

l

n
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Modify the contact pair parameters
for Ribs

a. Highlight
2D_bdy1_2D_bdy5_pair

b. Click Modify Data…

c. Enter 0.02 for Distance
Tolerance

d. Check Glued Contact, Retain
Gaps/Overlaps, and Retain
Moment.

e. Check Stress Free InitCont

f. Select Automatic under
Contact Detection

g. Click OK

h. Click Apply

Step 4. Define Contact Pairs (Cont.)

a

b

c

d

e

f

g h
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Modify the default load case to add
Displacement and Load applied to
the current loadcase. (They have
been previously defined in the
input deck imported in this
workshop)

a. On the Loads/BCs tab, click
Create Load Case.

b. Pull down Action > Modify.

c. Select the Default load case.

d. Click on the Displ_spc1.1 and
Press_pload4.1.2D
Loads/BCs. They should
appear on the list of Loads/BCs
below.

e. Click OK.

f. Click Apply.

Step 5. Modify the Load Case

a

b

c

d

e

f
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Create a pinned constraint on
the axial edges:

a. Click Reset Graphics.

b. Click on Model Tree in
Home tab.

c. Click Displacement in
Model Tree to view this BC
on model.

d. Click Press_pload4.1.2D.
in Model Tree to view this
BC on model.

e. Click Reset Graphics.

Step 6. View Boundary Conditions

d

b

e

c

a

d
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Set up the Nonlinear static
analysis.

a. Under the Analysis tab, click
Entire Model in the Analyze
group.

b. Enter curved_glued_contact
for Job Name.

c. Click Solution Type.

d. Select Implicit Nonlinear for
Solution Type.

e. Click Solution Parameters.

f. Click Results Output Format.

g. Uncheck XDB and check OP2.

h. Click OK.

i. Click OK.

j. Click OK.

Step 7. Set up Implicit Nonlinear Analysis
a

d

c

b

e

f

g

h

i

j
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Request Contact output.

a. Click Subcases.

b. Highlight Default under
Available Subcases.

c. Click Output Requests.

d. Highlight Contact Results
under Select Result Type.

e. Click OK.

f. Click Apply on the Subcases
form.

g. Click Cancel.

Step 7. Set up Implicit Nonlinear Analysis (Cont.)

d

c

b

a
e gf
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Run the analysis:

a. Click Subcase Select.

b. Highlight Default in the top
pane. Ensure Default is the
only subcase present under
Load Steps Selected.

c. Click OK.

d. Click Apply.

The job is written to
curved_glue_contact.bdf and
the analysis is run.

Step 7. Set up Implicit Nonlinear Analysis (Cont.)

a

d

b

c
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Attach the OP2 results:

a. Click AttachOutput2 in the Access
Results group.

b. Click Select Results File

c. Select curved_glued_contact.op2
from the list of Available Jobs.

d. Click Apply. Patran will look for the
results file with a name that matches
the Job Name.

Step 8. Attach the OP2 Results

a

b

c

d
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Review the deformation results:

a. Click Reset Graphics.

b. Under the Results tab, click Fringe/Deformation in the Quick Plot
group.

c. Highlight the second subcase SC1:DEFAULT, A1 Static Subcase.

d. Highlight Displacements, Translational for Fringe Result.

e. Highlight Displacements, Translational for Deformation Result.

f. Click Apply.

Step 9. Post Process with Patran

b

Check that the results
are reasonable. Note
that the displacement
contours flow across
the glued boundaries
with different mesh
sizes.

a

c

d

e

f
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Verify the contact status for each of the
contact bodies

a. Pull down Create/Marker/Scalar for
Action, Object, and Method, respectively.

b. Highlight the first Result Case SC0:,
A1:Static Subcase which contains the
contact results

c. Select Contact Status under Select
Scalar Result.

d. Click Display Attributes.

e. Enter 0.03 for Scale Factor.

f. Pull down the Scalar Style to your
preference.

g. Uncheck Show Scalar Label.

h. Click Reset Graphics.

i. Select Apply.

The contact status plot for the fine mesh is
displayed on the next page.

Step 10. Verify Contact Status

a

b

c

d

e

f

g

i

h



NAS400, Workshop 5, January 2015
Copyright© 2015 MSC.Software Corporation

WS5 - 22

Step 10. Verify Contact Status (Cont.)

Patran will place a scalar symbol on
every node that is in contact.
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WORKSHOP 6
PLASTIC DEFORMATION
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• Workshop Objectives

– Plastic Deformation

• Software Version

– Patran 2013

– MSC Nastran 2013.1

• Required Files

– Tip_load.db

• Problem Description

– The simulation is to use 3D solid finite elements. The elements are uniformly
spaced along the length of the beam (i.e. a mesh 100 elements wide and
four elements deep).
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• Problem Description (Cont.)

– A cantilever beam is subjected to a static load. In the previous workshop, the
beam is initially analyzed using small deformation theory. However, after
reviewing the results, it becomes apparent that small deformation theory is
not appropriate for this problem. A large deformation analysis using plastic
properties is performed.

Section A-A

b

a

(Data in next page)
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• Problem Description (Cont.)

Length, L 100.0 in 2.54 m

a 1.0 in 25.4 mm

b 2.0 in 50.8 mm

Young’s Modulus 30.0 x 106 lb/in3 207 GPa

Poisson’s Ratio 0.3 0.3

P 1200 lb 5338 N

Section A-A

b

a
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• Suggested Steps

1. Open the database tip_load from the Linear and Nonlinear Analysis of a
Cantilever Beam workshop.

2. Create a Plastic Property Table.

3. Add Plastic Property to the material, steel.

4. Change the element properties of the beam to use reduced integration.

5. Modify the Boundary condtions:

• Load tip load to 300 in Y direction. Applied to 4 nodes, 300x4=1200lbs.

• Create a 2nd loadcase for Unloading. Set scale factor of tipload to 0.

6. Create and run an implicit non-linear analysis.

• Select SOL400 Run in Solution Parameters.

• Select .OP2 as the result output format.

• In Load Increment parameters, set increment type to Adaptive

• Run the analysis.

• Attach the .OP2 result file.

7. Post-processing with Patran.

• Create a quickplot with the fringe of Plastic deformation to see where and if
Cantilever beams goes plastic.

• Create a quickplot with the fringe and deformation of the y component of the
displacement results.
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Open the database Tip_Load.db.

a. Pull down File > Open.

b. Select Tip_Load as the file
name.

c. Click OK.

Step 1. Open the Database

a

b

c

If you deleted Tip_Load.db, you may download
a copy of it in the Files folder of this course.



NAS400, Workshop 6, January 2015
Copyright© 2015 MSC.Software Corporation

WS6 - 8

Step 1. Open the Database (Cont.)

Change the viewport
display of the beam to
front view. Press the

Front View icon in the
Home tab under the
Orientation group.
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Create the Plastic Property Table.

a. Under the Properties tab, click
Material in the Fields group.

b. Enter plastic_s_e as the Field
name.

c. Uncheck the Temperature (T).

d. Check Strain (e).

e. Click Input Data.

f. Enter the data shown in the
table.

g. Click OK.

h. Click Apply.

Step 2. Create Plastic Property Table

Strain Stress

0 65000

0.5 1.565E6

(65000 is Yield Stress and 30E6 is
Young Modulus, considering
plastic range slope as 10% slope
of Elastic range so another point
on the curve can be calculated as
follows for the table
(0.1*30E6*0.5+65E3 = 1.565E6)

a

b

c
d

e

f

g

h
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• Elasto-Plastic material property can be entered in two ways:

– True Plastic Strain vs. True Stress: (Figure 1)

• Starts from Yielding Stress with zero plastic strain.

– Total True Strain vs. True Stress: (Figure 2)

• Starts from Zero Stress and Strain. Note that the 2nd point in the table definition has
to be the yield point and the slope should match exactly with the Young Modulus.

Note on Material Plastic Property entry.

(Figure 2)(Figure 1)



NAS400, Workshop 6, January 2015
Copyright© 2015 MSC.Software Corporation

WS6 - 11

Modify the existing material.

a. Under the Properties tab, click
Isotropic in the Isotropic
group.

b. Select steel from the Existing
Materials

c. Pull down Constitutive Model to
Elastoplastic.

d. Pull down Strain Rate Method
to Piecewise Linear.

e. Select plastic_s_e from the
Temperature/Strain/Strain Rate
Dependent Fields.

f. Click OK

g. Click Apply

Step 3. Apply Plastic Property to the Material

a

b

c

d

e

fg
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Now modify the properties
of the beam.

a. Under the Properties
tab, click Solid in the
3D Properties group.

b. Pull down Action to
Modify.

c. Select the property set
name beam.

d. Pull down Options:
Reduced Integration.

e. Check that steel is the
Material Name and
press OK.

f. Click Select
Application Region.

g. Select Solid 1.

h. Click OK.

i. Click Apply.

Step 4. Modify Physical Properties
a b

c

d

e

f

g

h i
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Create a 2nd Load Case

a. Right click Default in the Model Tree and
select Create.

b. Enter Name: Unloading

c. Click Input Date

d. Select Displ_fixed and Force_tip_load
from Select Indivudual Loads/BCs

e. Select Scale Factor for tip_load

f. Enter 0 for Scale Factor of tip_load.

g. Click OK

h. Click Apply

Step 5. Modify Loads/BCs

a

c

d

e

f

b

h

g
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Modify the applied tip load to each
node to be -300

a. Double click tip_load in Model
Tree

b. Modify Force <0,-300,0>.

c. Click OK

d. Click Apply

Step 5. Modify Loads/BCs (Cont.)

a

b

c

d
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Run a nonlinear analysis.

a. Under the Analysis tab, Click
Entire Model in the Analyze
group.

b. Enter Job Name: plastic_job3.

c. Click Solution Type…

d. Select IMPLICIT NONLINEAR.

e. Click on Solution Parameters.

Step 6. Analyze the Model

a

b

c

d

e
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Run Nonlinear analysis.

a. Confirm SOL 400 Run.

b. Confirm Assumed Strain.

c. Click on Results Output
Format.

d. Select OP2.

e. Click OK.

f. Click OK.

g. Click OK.

h. Click on Subcases.

Step 6. Analyze the Model (Cont.)

a

b

c

d

e

f

h

g
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Change Increment Type to
Adaptive

a. Select Default Subcase

b. Click on Subcase
Parameters.

c. Confirm that Nonlinear
Geometric Effects is set to
Large
Displacements/Large
Strains.

d. Click on Load Increment
Parameters.

e. Pull down Increment Type
is set to Adaptive.

f. Click OK.

g. Click OK

h. Click Apply

Step 6. Analyze the Model (Cont.)

b

c

d

f

e

h

g

a
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Change Increment Type to
Adaptive

a. Select Unloading
subcase

b. Click on Subcase
Parameters.

c. Confirm that Nonlinear
Geometric Effects is set to
Large
Displacements/Large
Strains.

d. Click on Load Increment
Parameters.

e. Confirm Increment Type is
set to Adaptive.

f. Click OK.

g. Click OK

h. Click Apply

Step 6. Analyze the Model (Cont.)

b

c

d

f

e

h

g

a
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Add both Steps for analysis, and
run the job.

a. Click Subcase Select

b. Select Unloading

c. Click OK

d. Click Apply to run the job.

Step 6. Analyze the Model (Cont.)

a

b

c
d
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Run the Job.

a. Click Apply.

b. Click Monitor

c. Click View STS file to check the job
is done.

d. Check Job terminate normally. Exit
number to be 0.

Step 6. Analyze the Model (Cont.)

a

b

d c
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Access the results from the
nonlinear analysis.

a. Under the Analysis tab, click
Attach Output2 in the Access
Results group.

b. Click on Select Results File.

c. Select the file plastic_job3.

d. Click OK.

e. Click on Apply.

Step 6. Analysis: Access Results

c

d

a

b

e



NAS400, Workshop 6, January 2015
Copyright© 2015 MSC.Software Corporation

WS6 - 22

Post-process the job results.

a. Under the Results tab, click
Fringe/Deformation in the Quick Plot group.

b. Select Default A1: Non-linear: 100. of Load
from Select Results Cases.

c. Select Nonlinear Stress, Plastic Strain from
Select Fringe Result.

d. Select Displacements, Translational from
the Select Deformation Result.

e. Click on Deform Attributes icon.

f. Select True Scale.

g. Click Apply.

h. Click Fit View to get a view of the entire
beam.

Step 7. Create a Fringe Deformation Plot

a

f

g

h

b

c

e

d
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Step 7. Create a Fringe Deformation Plot (Cont.)

Plastic
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Create Fringe deformation plot with deformation to better
evaluate the deformation after loading and unloading

a. Click on Select Results icon.

b. Select A1:Non-linear: 200. % of Load

c. Select Displacement Translational in Fringe results

d. Pull down Quantity to Y Component.

e. Click Apply

Create Plot at 100% of Load (At complete Loading) and
compare the plots (Next Page)

Step 7. Create a Fringe Deformation Plot

a

d

Does Not go Back to original Location
after unloading due to plastic
deformation.

b

c

e
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Compare Results of Deformed shape

UnloadedLoaded
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WORKSHOP 7
SOLID SHELL COMPOSITES

MODELING
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• Workshop Objectives

– Become familiar with setting up a solid composite shell model

• Software Version

– Patran 2013

– MSC Nastran 2013.1

• Files Required

– solid_shell.db
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• Problem Description

– Simulate a three-point-bending composite test specimen using solid composite shell elements

– Due to symmetry, only a quarter of the specimen is modeled.
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Material Name % Thickness Orientation

1 Ortho1 1e-3 0

2 Ortho1 9.999 0

3 Ortho1 10 90

4 Ortho1 10 0

5 Ortho1 40 90

6 Ortho1 10 0

7 Ortho1 10 90

8 Ortho1 9.999 0

9 Ortho1 1e-3 0

• Problem Description (cont.)

– You will build a laminate by entering each ply thickness as a percentage of the
total thickness

– Two very thin outer plies are used to pick up stresses at the outside faces of
the part.

Stress recovery ply

Stress recovery ply
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• Suggested Steps

1. Open solid_shell.db

2. Review load and boundary conditions by plotting markers

3. Verify element coordinate systems

4. Create Orthotropic material properties

5. Create a laminated composite

6. Create a 3D solid properties

7. Set up the Analysis

8. Attach OP2 results file

9. Plot Deformation and Fringe results
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a

Start Patran and open a database
containing the composite coupon:

a. Click File Open in the Defaults
group.

b. Select solid_shell.db as the
File name.

c. Click OK.

Step 1. Open an existing Patran Database

c

b
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Plot loads and boundary
conditions:

a. Click the Loads/BCs tab.

b. Set Action to Plot Markers.

c. Select Displ_simple_bc
and click Apply. This plots
the simple support in the
vertical direction.

d. Select Displ_sym1 and
click Apply. This plots the
X symmetry constraints.

e. Select Displ_sym2 and
click Apply. This plots the
Y symmetry constraints.

f. Select Force_force1 and
Force_force2 and click
Apply. This plots the
applied load.

g. Click Reset Graphics to
clear the markers.

Step 2. Review Loads and Boundary Conditions
a

b

c
d
e

f

g
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Verify the element coordinates
systems:

a. Click the Meshing tab.

b. Set action to Show.

c. Set Object to Element.

d. Set Info to Coord. Sys.

e. Click on any element to
review the element
coordinate system.

f. Click on a few more
elements to review the
element coordinate system.
Make a mental note of the
element Z direction.

g. Click Reset Graphics.

Step 3. Verify Element Coordinate System
a

b

c

d

g

e

f
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Create a material property:

a. Click the Properties tab.

b. Click 3D in the Orthotropic group.

c. Name the Material ortho1

d. Click on Input Properties

e. Enter the values shown.

f. Click OK.

g. Click Apply.

Step 4. Create Material Property

b

c

e

f

g

d

a
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Create a Laminated Composite:

a. In the Properties tab, click
Laminate in the Composite
group.

b. Name the Material lam1.

c. Click on ortho1 9 times to
create 9 rows in the table

d. Select “Total-%thickness”
from the Stacking Sequence
Convention

e. Click in the first %thickness cell

f. Click in the Input Data field and
enter 0.001 and press the
Enter key.

g. Repeat step f to enter all ply %
thickness values as shown on
the right. Make sure the total
percentage is 100 when you
are done.

h. Click in the first Orientation cell

i. Enter the ply angles one at a
time as shown.

j. Click Apply.

Step 5. Define the Composite Layup

b

c

j

a

d

c

e

f g

h

i
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Create 3D solid property:

a. In the Properties tab, click
Solid in the 3D Properties
group. (you may have to
move the Laminated
Composite form out of the
way).

b. For Property Set Name, enter
3d-comp.

c. Change Options to Laminate.

d. Click Input Properties…

e. Click Material Prop Name icon
and select lam1.

f. Click in the Material
Orientation box, then screen
select Coord 1.

g. For Thickness Direction 3D,
select Element Z Direction.

h. In SCOMP Integration
Scheme, select Assumed
Strain.

i. Click OK.

Step 6. Create Solid Property

a

c

b

d

e

f

e

g

h

i

f
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Create 3D solid property:

a. Click Select Application
Region …

b. Rectangle select both solids.

c. Click Add.

d. Click OK.

e. Click Apply.

Step 6. Create Solid Property (Cont.)

a

c

d

e

b
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Select solution type:

a. Click the Analysis tab.

b. Enter
three_point_bending for
Job Name.

c. Click on Solution Type.

d. Select Implicit Nonlinear.

e. Click Solution
Parameters.

f. Check Shell Shear
Correction and SOL 400
Run.

Step 7. Set up Analysis

b

d

e

f

a

c



NAS400, Workshop 7, January 2015
Copyright© 2015 MSC.Software Corporation

WS7 - 15

a. Select Results Output
Format….

b. Check OP2 and uncheck
MASTER/DBALL.

c. Click OK.

d. Click OK.

Step 7. Set up Analysis (Cont.)

a

b

d

c

b
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Define subcase parameters:

a. Click Subcases.

b. Select Default

c. Click Subcase
Parameters.

d. Set Linearity to Linear.

e. Click OK.

f. Click Apply.

g. Click Cancel.

h. Click Apply.

The analysis will take less
than a minute to run.

Step 7. Set up Analysis (Cont.)

a

b

d

e

c

f g
h
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Attach the results file:

a. Click Attach Output2 in the
Access Results group.

b. Click on Select Results File.

c. Select the results file
three_point_bending.op2.

d. Click OK.

e. Click Apply.

Step 8. Attach Results
a

b

c

d

e
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Plot deformation:

a. Click the Results tab.

b. Click the Deformation icon.

c. Select Displacement,
Translational for
Deformation Result.

d. Click Apply.

Step 9. Plot Results

c

d

a

b
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Plot stresses:

a. Click the Fringe icon.

b. Select Composite Stress, Ply
Stress for Fringe Result.

c. Set Position to Layer 1 at
middle.

d. Set Quantity to
X Component.

e. Click Apply.

Step 9. Plot Results (cont.)

b

e

a

c

d
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WORKSHOP 8
DELAMINATION OF A COMPOSITE

SOLID SHELL BEAM
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• Workshop Objectives

– Perform a CZM delamination analysis.

– Create contact pairs.

– Create cohesive material

– Create interface elements.

• Software Version

– Patran 2013

– MSC Nastran 2013.1

• Required File:

– build_shear.czm.ses
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• Problem Description

1. Two composite plates are glued together with a adhesive layer.

2. One end of the plates is fixed and pulling on the other end.

3. The exponential cohesive material model is used the interface elements.

Cohesive Layer

Composite Plates

Fixed

Pull

Gc = 3.0 in-lb/in2

Vc = 0.0002
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• Suggested Exercise Steps

1. Create a new database.

2. Play session file “build_shear_czm.ses.”

3. Review the model boundary conditions with the model tree.

4. Review the contact bodies in the model.

5. Create the composite material and layup.

6. Create the contact pairs.

• Check Glued Contact

• Master = plate_lower

• Slave = interface

• Repeat for the upper plate

7. Create cohesive material.

• Select exponential for the Constitutive Model

• Enter 3 for Cohesive Energy

• Enter 0.0002 for displacement

8. Create cohesive interface element property for all wedge elements.

9. Set up the analysis job.

• Implicit Nonlinear for Solution Type

• Uncheck Permanent Gluing

• Request op2
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• Suggested Exercise Steps (Cont.)

• Use an adaptive increment type with a maximum time step of 0.05

• Output Nonlinear Stresses

10. Review the sts file.

11. Attach op2 results file.

12. Plot interface damage.

• Set all time increments to display Element Edges and show True
Scale

• Plot damage at Time = 0.6579891

13. Graph load vs. x-deflection curve of the independent node of the
RBE2s to view the constraint forces at all time increments.
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Create a new database called
CZM:

a. Under the Home tab, click New
in the Defaults group.

b. Enter CZM as the File name.

c. Click OK.

d. For the New Model Preference,
accept all defaults by clicking
OK.

Step 1. Create a New Database

a

b c
d
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Play session file:

a. Select File > Session > Play.

b. Select build_shear_czm.ses.

c. Click Apply.

Step 2. Play Session File

b

c

a
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Review the model boundary conditions with the model tree :

a. Under the Home tab, click Show/Hide Model Tree in the Model Tree group.

b. Expand LBCs and check the box next to Displacements.

c. Observe the loads and boundary conditions.

d. Uncheck when done reviewing the boundary conditions.

Step 3. Review the Model Boundary Conditions
a

b

c
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Review the contact bodies:

a. Under the Load/BCs tab, click Color Code Bodies in the Contact Bodies group.

b. Set Object to Contact.

c. Select all the Existing Sets.

d. Select Group Color.

e. Click Apply.

f. Observe the contact bodies.

g. Click on Reset Graphics.

Step 4. Review the Model Contact Bodies

b

c

a

f
d

e

g
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Create a material property:

a. Click the Properties tab.

b. Click 3D in the Orthotropic
group.

c. Name the Material ply

d. Click on Input Properties

e. Enter the values shown.

f. Click OK.

g. Click Apply.

Step 5. Create the Composite Material and Layup

b

a

c

e

f
g

d
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Create a Laminated Composite:

a. In the Properties tab, click
Laminate in the
Composite group.

b. Name the Material
composite.

c. Click on ply 8 times to
create 8 rows in the table

d. Select “Total” from the
Stacking Sequence
Convention

e. Click in the first thickness
cell

f. Click in the Input Data field
and enter 0.01 and press
the Enter key.

g. Repeat step f to enter all
ply thickness values as
shown on the right.

h. Click in the first Orientation
cell

i. Enter the ply angles one at
a time as shown.

j. Click Apply.

Step 5. Create the Composite Material… (Cont.)

a

b

c
d

e

f g

h

i

j
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Create 3D solid property:

a. In the Properties tab, click
Solid in the 3D Properties
group. (you may have to
move the Laminated
Composite form out of the
way).

b. For Property Set Name, enter
plate_lower.

c. Change Options to
Laminate.

d. Click Input Properties…

e. Click Material Prop Name
icon and select composite.

f. Click in the Material
Orientation box, then screen
select Coord 0.

g. For Thickness Direction 3D,
select Element Z Direction.

h. In SCOMP Integration
Scheme, select Assumed
Strain.

i. Click OK.

Step 5. Create the Composite Material… (Cont.)
a

c

b

d

e

f

g

h

i

f
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Create 3D solid property:

a. Click Select
Application Region
…

b. Under the Home tab,
click Show/Hide
Model Tree in the
Model Tree group.

c. Expand Groups and
only check the box
next to Lower.

d. Select Solid element.

e. Select Pick All.

f. Click Add.

g. Click OK.

h. Click Apply.

Step 5. Create the Composite Material… (Cont.)

a

c

b

d

e

f

g

h
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Create 3D solid property:

a. In Property Set Name,
enter plate_upper.

b. Click Input Properties…

c. Click OK to accept
changes from the
previous property.

Step 5. Create the Composite Material… (Cont.)

a

c

b
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Create 3D solid property:

a. Click Select
Application Region …

b. Expand Groups and
only check the box next
to upper.

c. Select Solid element.

d. Select Pick All.

e. Click Add.

f. Click OK.

g. Click Apply.

h. Check the box next to
upper and interface

Step 5. Create the Composite Material… (Cont.)

a

c

b
d

e

f

g

h

h
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Create the contact pairs:

a. Under the Loads/BCs tab, click
Create Body Pair in the Body
Pairs group.

b. Enter lower_glue for New Set
Name.

c. Click Input Data.

d. Check the box for Glued
Contact(IGLUE).

e. Click OK.

Step 6. Create the Contact Pairs

a

b

c

d

e
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Create the contact pairs
(cont.):

a. Click Select Application
Region.

b. Click icon for
Body1/Master/Touched
and click plate_lower.

c. Click icon for
Body2/Slave/Touching
and click interface.

d. Click OK.

e. Click Apply.

Step 6. Create the Contact Pairs (Cont.)

a

b

c

d

e

b

c
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Create the contact pairs (cont.):

a. Enter upper_glue for New Set
Name.

b. Click Input Data.

c. Check the box for Glued
Contact(IGLUE).

d. Click OK.

Step 6. Create the Contact Pairs (Cont.)

a

b

c

d
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Create the contact pairs (cont.):

a. Click Select Application
Region.

b. Click icon for
Body1/Master/Touched and
click plate_upper.

c. Click icon for
Body2/Slave/Touching and
click interface.

d. Click OK.

e. Click Apply.

Step 6. Create the Contact Pairs (Cont.)

a

b
b

c

c

e

d
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Create cohesive material:

a. Under the Properties tab, click
Cohesive.

b. Enter Material Name cohesive.

c. Click Input Properties.

d. Select Exponential for
Constitutive Model.

e. Enter 3 for Cohesive Energy.

f. Enter 0.0002 for Critical
Opening Displacement.

g. Click OK.

h. Click Apply.

Step 7. Create Cohesive Material

b

d

a

c

e
f

g
h
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Create cohesive interface
element property:

a. Under the Properties tab,
click Solid.

b. Enter Property Set Name
interface.

c. Select Interface option.

d. Click Input Properties.

e. Click material icon.

f. Select cohesive.

g. Click OK.

Step 8. Create Interface Element Property

b

d

a

c

e

f

g
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Create cohesive interface element
property (cont.):

a. Click Select Application
Region.

b. Select Wedge Element filter.

c. Select all wedge elements.

d. Click Add.

e. Click OK.

f. Click Apply.

Step 8. Create Interface Element Property (Cont.)

b

d

a

c

e

f
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Set up job parameters:

a. Under the Analysis tab, click
Entire Model in the Analyze
group.

b. Click Solution Type.

c. Select Implicit Nonlinear.

d. Click Solution Parameters.

e. Click Contact Parameters.

Step 9. Set up the Analysis Job

b

d

a

c

e
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Set up job parameters (cont.):

a. Click Contact Detection.

b. Uncheck Permanent
Gluing (NLGLUE).

c. Click OK.

d. Click OK.

e. Click Results Output
Format.

f. Only check OP2.

g. Click OK.

h. Click OK.

Step 9. Set up the Analysis Job (Cont.)

a

b

c d

e

f

h

g
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Set up job parameters (cont.):

a. Click OK.

b. Click Subcases.

c. Select Default under Available
Subcases.

d. Click Subcase Parameters.

Step 9. Set up the Analysis Job (Cont.)

a

b

c

d
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Set up job parameters (cont.):

a. Click Load Increment
Params.

b. Select Adaptive for Increment
Type.

c. Enter 0.05 for Maximum Time
Step.

d. Click OK.

e. Click OK.

f. Click Output Requests.

Step 9. Set up the Analysis Job (Cont.)

a

c

b

e
d

f
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Set up job parameters (cont.):

a. Select Non-Linear Stress
under Select Result Type.

b. Click OK.

c. Click Apply.

d. Click Cancel.

e. Click Apply.

Step 9. Set up the Analysis Job (Cont.)

a

b

dc

e
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a. Open CZM.sts file to check the job status – normal completion if job ends with exit number 0.

Step 10. Review the sts Files

a
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Attach Results file:

a. Under the Analysis tab, click
the Attach Output2 in the
Access Results group.

b. Click Select Results File.

c. Browse to the working
directory and select czm.op2

d. Click OK.

e. Click Apply.

Step 11. Attach MASTER Results File

b
c

e

a

d
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Plot interface damage:

a. Under the Results tab, click
Fringe/Deformation in the
Quick Plot group.

b. Under the Select Result Cases,
select all increments except the
first one.

c. Select Damage Value under
Select Fringe Result.

d. Select Displacements,
Translational under Select
Deformation Result.

e. Click the Fringe Attributes
icon.

f. Select Element Edges for
Display.

g. Click the Deform Attributes
icon.

h. Select True Scale.

i. Uncheck Show Undeformed.

j. Click Apply.

Step 12. Plot Interface Damage

c

d

e
g

f

b

a

h

i

j
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Plot interface damage at
specified time:

a. Under the Results tab,
click Fringe/Deformation
in the Quick Plot group.

b. Select results case at
Time = 0.6579891 under
Select Result Cases.

c. Select Damage Value
under Select Fringe
Result.

d. Select Displacements,
Translational under
Select Deformation Result.

e. Click Apply.

Step 12. Plot Interface Damage (Cont.)

a

b

c

d

e
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Graph load-deflection curve:

a. Click Reset Graphics.

b. Under the Home tab, click
Smooth shaded in the Display
group.

c. Zoom in to the right edge of the
top plate.

Step 13. Graph Load-Deflection Curve

b

c

a
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Step 13. Graph Load-Deflection Curve (Cont.)

Graph load-deflection curve of the
independent node of the RBE2s:

a. Change the Object to Graph.

b. Change the Method the Y vs X.

c. Under the Select Result Cases,
select all increments except the first
one.

d. Select Constraint Forces
Translational under Select Y Result.

e. Pull down Quantity to X Component.

f. Pull down X to Result.

g. Click Select X Result.

h. Select Displacements,
Translational under Select X Result.

i. Pull down Quantity to X Component.

j. Click OK.

a
b

c

d

e

f
g

h

i

j
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Graph load-deflection curve
(cont.):

a. Click the Target Entities icon.

b. For the Target Entity select
Nodes.

c. Select the Node highlighted in
the image or enter Node 3000
in the Select Nodes box.

d. Click Apply.

Step 13. Graph Load-Deflection Curve (Cont.)

a

b

c

d
c
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Step 13. Graph Load-Deflection Curve (Cont.)
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WORKSHOP 9
RESTART
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• Workshop Objectives

– Use Restart Parameter

• Software Version

– Patran 2013

– MSC Nastran 2013.1

• Required File:

– Model_run1.bdf
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• Problem Description

Steel Plate fixed on one side, force applied in the middle for 0.01 seconds and
the removed.

1. This is Dynamic Transient analysis and in the first run, the load is being
applied up to 0.05 seconds.

2. In the second run, the user restart the previous analysis, and runs the
analysis for another 0.05 seconds
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• Suggested Exercise Steps

1. Review model_run1.bdf deck.

2. Run the analysis using MSC Nastran.

3. View the result in Patran

4. Copy the Master/DBALL result file and rename it.

5. Open the model_run1.bdf and modify it accordingly.

6. Save it as model_run2.bdf

7. Attach the result to the same Patran Database.

8. Plot displacement vs. time in Patran.
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Open the model_run1.BDF file.

a. Click model_run.bdf

b. Review the file, make note its
SOL 400.

Step 1. Review BDF file.

a

b
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Submit the job to MSC Nastran.

a. Open MSC Nastran

b. Select model_run1.bdf

c. Click Open

d. Click Run

Step 2. Run the job

a

b

c
d
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a. Open Patran.

b. Click New

c. Go to Working directory and create a
database called: Model_1

d. Click OK

Step 3. View the result in Patran

a

b

c
d
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Open the *.xdb result file in Patran
for post processing

a. Under the Analysis tab, Click
XDB, in the group Access
Results

b. Pull down Method > Both

c. Click Select Result File

d. Select model_run1.op2

e. Click OK

f. Click Apply

Step 3. View the result in Patran (Cont.)

a

b

c

d

f

e
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View the deformed shape using
quick plot in Patran.

a. Under the Result tab, click
Quick Plot.

b. Select the last Result case,
Make note its at time 0.05

c. Select Displacement,
Translational in Select
Fringe Result

d. Pull down Quantity > Z
Component

e. Select Displacements,
Translational in Select
Deformation Result

f. Click Apply

Step 3. View the result in Patran (Cont.)

a

b

c

f

e

d
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Plot Graph of Displacement vs.
Time

a. Under the Result tab, click
Graph

b. Select View all result Cases

c. Select All result cases

d. Select Displacement
Translational

e. Pull down Quantity > Z
Component

f. Select Target Entity tab

g. Select Node 1

Step 3. View the result in Patran (Cont.)

a

d

e

f

g

b

c
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Time vs. Displacement in First Run
0 to 0.05 sec



NAS400, Workshop 9, January 2015
Copyright© 2015 MSC.Software Corporation

WS9 - 13

Make a copy of *.DBALL file for
Restart run.

a. Copy model_run1.DBALL,
model_run1.MASTER and
model_run1.bdf paste it in
same folder.

b. Rename them to
model_run1_r.DBALL,
model_run1_r.MASTER and
model_run1_r.bdf

c. Open model_run1_r.bdf

Step 4. Copy the Result file for Restart
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a. Add the following lines:

Step 5. Modify Restart file

ASSIGN MASTER='model_run1_r.MASTER'

RESTART

SOL 400

CEND

NLRESTART

TITLE = MSC.Nastran job

ECHO = NONE

$ Direct Text Input for Global Case Control Data

SUBCASE 1

$ Subcase name : Default

ANALYSIS = NLTRAN

SUBTITLE=Default

TSTEPNL = 1

spc=11

disp(plot)=all

velocity(plot)=all

stress(plot)=all

STEP 1

DLOAD = 2

STEP 2

TSTEPNL = 20

DLOAD = 2

BEGIN BULK

param,post,1

PARAM LGDISP 1

TSTEPNL 1 50 .001 AUTO UPW

TSTEPNL 20 50 .001

Note that the original Step should

not be removed from the analysis.

Nonlinear Restart is not supported

in SOL 400 if advanced elements

are used.
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Submit the job to MSC Nastran.

a. Open MSC Nastran

b. Select model_run1_r.bdf

c. Click Open

d. Click Run

Step 6. Run the Restart job.
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Open the *.xdb result file in Patran
for post processing

a. Under the Analysis tab, Click
XDB, in the group Access
Results

b. Pull down Method > Both

c. Click Select Result File

d. Select model_run1_r1.xdb

e. Click OK

f. Click Apply

Step 7. View the Result in Patran
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View the deforemed shape
using quick plot in Patran.

a. Under the Result tab, click
Quick Plot.

b. Select the last Result case,
Make note its at time = 0.1

c. Select Displacement,
Translational in Select
Fringe Result

d. Select Displacements,
Translational in Select
Deformation Result

e. Click Apply

Step 7. View the Result in Patran (Cont.)
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Plot Graph of Displacement vs.
Time

a. Under the Result tab, click
Graph

b. Select View all result Cases

c. Select All result cases

d. Select Displacement
Translational

e. Pull down Quantity > Z
Component

f. Select Target Entity tab

g. Select Node 1

Step 7. View the result in Patran (Cont.)
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Plot Displacement vs. Time

Restart RunRun1
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WORKSHOP 10
BOLT MODELING
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• Software Version

– MSC Nastran 2013.1

– Patran 2013

• Files Required

– bolted_plates.xmt

• Problem Description

– Modeling Bolt preload using Patran and apply external load and analysis
using SOL400.

Workshop Objectives
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• Suggested Steps
1. Create a New database, call it bolt_modeling
2. Import bolted_plates.xmt
3. Define groups for plates and bolts to ease the work for further steps.
4. Mesh the geometry one by one using TET10 elements.
5. Modify the groups by Group Reorganize to assign mesh to its corresponding group.
6. Define Material Properties: Steel. Elastic Modulus 30,000,000 psi, Poisson ratio 0.3
7. Define Geometric Property: Solid Homogenous with Standard Formulation
8. Define new Loadcase bolt_preload_step1
9. Define 5 Deformable Contact Bodies based on groups.
10.Define contact Pairs. Between plates, and between plates and bolts. Use Friction

coefficient: 0.3
11.Modeling Bolt Preload using Patran tools. with 450 Axial Bolt Load for each bolt.
12.Define Boundary Condition, Clamp the lower plate
13.Define Implicit Nonlinear job SOL400, request op2 output, activate quadratic contact,

request output for all increments.
14.Post process preloading step. plot displacement and Stresses.
15.Define loadstep for Bolt_locking and make forces on bolts zero.
16.Lock the bolts.
17.Define a new loadcase for External load.
18.Apply Total load on the tip of Upper Plate.
19.Create a job implicit nonlinear for all three steps. preloading, locking, external loading.
20.Attach OP2 result file and deattach the old result file.
21.Plot Von Mises Stresses on bolts and plates after Appling the external load.

• plot history of the reaction force on bolts
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Bolt Modeling – 3 Steps

Step 2
Bolt Lock

Step 3
External Load

Step 1
Bolt Preload
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a. Click New in the Defaults
group

b. Enter bolt_modeling for
File_name

c. Click OK

d. Pull down Analysis Code >
MSC.Nastran

e. Pull down Analysis Type >
Structural

f. Click OK

Step 1. Create a New Database

f

b

a

c

d

e
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a. Pull down File > Import

b. Pull down Source >
Parasolid xmt

c. Select
bolted_plates.xmt

d. Click Apply

e. Click OK

Step 2. Import the Model

e

d

c
b

a
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Define groups for plates and bolts
to ease the work for further steps.

a. Pull down Group > Create

b. Enter Name: Upper

c. Uncheck Make Current and
check Posted

d. Click Entity Selection

e. Select Upper Plate (Solid 5)

f. Click Apply.

Do the same for the following

Lower: Solid 4

Left_bolt: Solid 2

Mid_bolt: Solid 3

Right_bolt: Solid 1

g. In the Model Tree, there should
be 6 groups.

Step 3. Create Groups

a

b

c

d

e

f

c

g
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Mesh the geometry one by one
using TET10 elements.

a. Under the Meshing tab, click
Solids, in the Meshers group.

b. Pull down Element Shape > Tet

c. Pull down Mesher > TetMesh

d. Pull down Topology > Tet10

e. Select the two plates

f. Uncheck Automatic
Caluclation and use Value
0.25

g. Click Apply.

h. Select Three Bolts.

i. Enter Global Length Value:
0.15

j. Click Apply

Step 4. Mesh The Geometry

a

b
c

d
e

h

f

g

i

j

e
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a. Notice that the current group
is the default_group.

b. In the Model Tree, Uncheck
Groups and then individually
check each of 6 groups to
post and notice that the
elements are just assign to
the default_group.

c. Pull down Utilities > Group >
Group Reorganize …

d. Select All in the Group
Selection.

e. Click Apply.

f. Repeat Step b to check
every group is associated
with its own elements.

Step 5. Group Reorganize
a

b

d

e

f

c
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Define Material Properties

a. Under the Properties tab, click
Isotropic

b. Enter Name Steel

c. Click Input Data

d. Enter 30000000 for Elastic
Modulus.

e. Enter 0.3 for Poisson Ratio

f. Click OK

g. Click Apply

Step 6. Define Material Properties

a

b

c

d

e

f

g
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Define Solid geometric properties
as Solid.

a. Click Solid in 3D Properties
group.

b. Enter Prop for Name

c. Click Input Properties

d. Click Material Icon

e. Select Steel

f. Click OK

g. Click Select Application
Region

h. Select Pick All

i. Click Add

j. Click OK

k. Click Apply

Step 7. Define Geometric Properties

a

b

c

d

e

f

g

h

i

j

k
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a. Under the Loads/BCs tab, click
Create Load Case in the Load
Cases group

b. Enter bolt_preload_step1 for
Load Case Name

c. Check Make Current

d. Click Apply

Step 8. Create a New Loadcase

c

d

b

a
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Define Contact Bodies using automatic
tool in Patran.

a. Pull down Tools>Modeling> Contact
Bodies/Pairs…

b. Pull down Method > Groups

c. Check Select Groups.

d. Select the five created groups.

e. Click Apply

f. Check Model Tree, 5 Deformable
body will be created.

Step 9. Define Contact Bodies

a

b

c

d

cf

e
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Define contact pair between two
plates.

a. Pull down Create > Body Pair

b. Select Select Bodies

c. Select Lower_3D and
Upper_3D from Existing Bodies
list.

d. Select Specify in Contact
Properties Set

e. Rename Geometric Property to
Plate_geom_prop

f. Rename Physical Property to
Plate_phy_prop

g. Click Apply

h. One Contact Pair gets
generated

i. Click OK

Step 10. Define Contact Pairs

a

b

c

d
e

g

h

f

i
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Define contact pair between two
plates.

a. Enter 0.1 for Distance Tolerance

b. Select Entire Model

c. Rename Geometric Property to
Bolt_geom_prop

d. Rename Physical Property to
Bolt_phy_prop

e. Click Apply

f. Click No on Message for
overwriting pair.

g. 6 Pairs gets generated.

h. Click OK

i. Click Cancel to close the Create
Pair window.

Step 10. Define Contact Pairs (Cont.)

a

b

c

d

e

f

g

h

i
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Add friction coefficient between the
plates.

a. Double-click
Lower_3D_Upper_3D_pair

b. Click Physical Prop.

c. Enter 0.3 Friction Coefficient

d. Click OK

e. Click Apply

f. Double-click
Left_bolt_3D_Lower_3D_pair

Repeat step b, c d and e to add
Friction coefficient of 0.3 between
bolts and the plates.

Step 10. Define Contact Pairs (Cont.)

a

b

c

d

e

f
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a. Pull down Group > Post

b. Select Left_bolt, Mid_Bolt, Right_bolt.

c. Click Apply

d. Pull down Tools > Modeling > Bolt Preload

e. Enter bolt_1 for New Bolt Model Names

f. Enter 450 for Axial Bolt Load

g. Enter <0 0 1> for Direction Vector

h. Screen select all of the elements of one bolt,
use the CTRL to draw arbitrary selection.
Do the same for every bolt.

i. Click Cancel

Step 11. Modeling Bolt Preload

h

g

f

e

d

i

a

b

c
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Preloaded Bolt Defined
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1. Splits Bolt

2. Creates MPCs
tied to Control Node

3. Creates Local
Coordinate Frame

Step 11. Modeling Bolt Preload (Cont.)
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Step 12. Define Boundary Conditions

Post all of the Groups

a. Pull down Group > Post

b. Select all the five groups

c. Click Apply

a

c

b
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a. Under the Loads/BCs tab, click
Displacement Constraint in
the Nodal group

b. Enter plate for New Set Name

c. Click Input Data…

d. Enter <0,0,0> for Translations

e. Click OK

Step 12. Define Boundary Conditions (Cont.)

c

b

a

e

d
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a. Click Select Application Region…

b. Pull down Select > Geometry

c. Click Surface or Face from the Picking
Filters toolbar

d. Screen select the edges the lower plate
(Solid 4.8)

e. Click Add

f. Click OK

g. Click Apply

Step 12. Define Boundary Conditions (Cont.)

f

d

e

c

b

a

g
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a. Click Create Load Case in the
Load Cases group

b. Click bolt_preload_step1 for
Existing Load Cases

c. View the Assigned Loads/BCs
there should be 5 contacts, 4
displacements, and 3 force

d. Click OK when done

Step 12. Define Boundary Conditions (Cont.)

d

c

b

a
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Define a job named bolt, to run the
Implicit Nonlinear analysis SOL400.

a. Under the Analysis tab, click
Entire Model in the Analyze tab

b. Click Solution Type…

c. Select Implicit Nonlinear

d. Click Solution Parameters…

Step 13. Define Job

d

c

b

a
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a. Click Results Output
Format…

b. Check OP2

c. Click OK

d. Click Contact Parameters

Step 13. Define Job (Cont.)

b

c

d

a
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Activate Quadratic Contact
LINQUAD.

a. Click Contact Detection.

b. Select Activate Quadratic
Contact (LINQUAD)

c. Click OK.

d. Click Friction

e. Pull down Type > Bilinear
Coulomb

f. Click OK

Click OK on all preceding forms.

Step 13. Define Job (Cont.)

a

b

c

d

e

f
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Request for outputs

a. Click Subcases

b. Select botl_preload_step1

c. Click Output Requests…

d. Switch Form Type > Advanced

e. Pull down Intermediate Output Option > All

f. Check Displacement, Stress and SPCFORCES and
Applied Load are requested in Output Requests.

g. Click OK

h. Click Apply

i. Click Cancel

Step 13. Define Job (Cont.)

a

b

c

d

e

f

g

h i
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Select Correct Subcase and run
the analysis.

a. Click Subcase Select…

b. Unselect Default and select
bolt_preload_step1

c. Click OK

d. Click Apply

Step 13. Define Job (Cont.)

b

d
c

a
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Attach OP2 result file

a. Under the Analysis tab, click
Attach Output2 in the Access
Results group.

b. Click Select Results File…

c. Select bolt_modeling.op2

d. Click OK

e. Click Apply

f. Pull down Group > Post

g. Select Left_bolt, Mid_Bolt,
Right_bolt.

h. Click Apply

Step 14. Attach Result File

b

a

f

g

c

d
e

h
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Plot fringe plot Displacement on
Bolts

a. Under the Results tab, click
Fringe, in the Results plots
group.

b. Select all increments in SC1

c. Select Stress Tensor

d. Click Apply

Step 14. Post Processing (Cont.)
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Plot Graph of applied load on
bolts.

a. Under the Results tab, click
Graph, in the Results plots
group.

b. Select all increments in SC1

c. Select Applied Loads,
Translational

d. Set X: to Global Variable,
Percent of Load

e. Click Target Entities

f. Pull down Target Entity >
Nodes

g. Select the control nodes of the
bolts.

h. Click Apply

Step 14. Post Processing (Cont.)
a

b

c

d

e

f

g

h
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Preloading the Bolts.
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Bolt Modeling – 3 Steps

- Displacement Constraints

- Contact Bodies (3)

- Bolt Pretension Load

- Bolt Control Node Lateral

Displacement Constraint (x,z)

- Displacement Constraints

- Contact Bodies

- Bolt Control Node Lock

Displacement Constraint (x,y,z)

- Displacement Constraints

- Contact Bodies

(3 Interference Fit)

- Bolt Control Node Lock

Displacement Constraint (x,y,z)

- External Load

Step 2
Bolt Lock

Step 3
External Load

Step 1
Bolt Preload
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Step 15. Define New Loadcase

Define new loadcase for Bolt lock

a. Under the Loads/BCs tab, click
Create Load Case

b. Click bolt_preload_step1

c. Click input Data

d. Make sure all the boundary
conditions and contact bodies
are listed

e. Enter 0 for Forces values

f. Rename Load Case to
bolt_lock_step2

g. Make sure Make Current is
also checked.

h. Click Apply

i. Click OK

a

b

c

e

d

i

f

h

g
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Step 16. Lock Bolts

Define new Boundary condition to fix
the control node in their local y
direction

a. Under the Loads/BCs tab, click
Displacement Constrain in the
Nodal group.

b. Enter Lock_left for Name.

c. Click Input Data

d. Enter < ,0, > in Translations

e. Select Coord 2 from the viewport on
the left bolt

f. Click OK

g. Click Select Application Region

h. Pull down Select > FEM

i. Select Control Node of the left bolt.

j. Click Add

k. Click OK

l. Click Apply

Do the same for the other two bolts
and fix them in their local Y axis.

a

b

c

d

e

g

h

f

j

i

l

k

e
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Create a new Loadcase called
External_Load_step3

a. Under the Loads/BCs tab, click
Create Load Case

b. Click bolt_lock_step2

c. Click input Data

d. Make sure all the boundary
conditions and contact bodies
are listed.

e. Rename Load Case to
External_load_step3

f. Make sure Make Current is
also checked.

g. Click Apply

h. Click OK

Step 17. Loadcase for External Load

a

b

ed

h

f

g

c
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Define External load applied to the
plates.

a. Click Total Load in the Element
Uniform group.

b. Enter Tip_load for Name

c. Click Input Data

d. Enter < , ,500>

e. Click OK

f. Click Select Application Region

g. Pull down Select > Geometry

h. Select the tip of upper plate

i. Click Add

j. Click OK

k. Click Apply

Step 18. Define External Load

a

b

e

d

f

c

a

g

h

j

i

k
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a. Enter bolt_3steps for Jon
Name

b. Click Solution Type

c. Click Solution Parameters.

d. Click Results Output
Format…

e. Check OP2

f. Click OK

g. Click OK

h. Click OK

Step 19. Define Job

d

e
h

g
c

b

a

f



NAS400, Workshop 10, January 2015
Copyright© 2015 MSC.Software Corporation

WS10 - 40

Run Analysis with all three steps of
bolt modeling.

a. Click Subcase Select…

b. Unselect Default and select
bolt_preload_step1
bolt_lock_step2
External_load_step3

c. Click OK

d. Click Apply

Step 19. Define Job (Cont.)

b

d
c

a
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Attach OP2 result file

a. Under the Analysis tab, click
Attach Output2 in the Access
Results group.

b. Pull down Action > Delete

c. Pull down Object > OP2
Attachment

d. Select Bolt_modeling.op2

e. Click Apply

f. Click Yes For All

g. Click Attach Output2 in the
Access

h. Click Select Results File…

i. Select bolt_3steps

j. Click Apply

Step 20. Attach Result File

a

i

h

c

e

d

f

g

b

j
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Plot fringe plot Displacement on
Bolts

a. Under the Results tab, click
Fringe/Deformation, in the
Results plots group.

b. Select last increment

c. Select Stress Tensor

d. Select Displacement
Translational

e. Click Deformation Attribute

f. Uncheck Show deformed

g. Click Apply

Step 21. Post Processing

a

b

c

a

d

e

g

f
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Von Mises Stress
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Post Bolts for post processings

a. Pull down Group > Post

b. Select Left_bolt, Mid_Bolt,
Right_bolt.

c. Click Apply

Step 21. Post Processing (Cont.)

a

b

c
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Plot Graph of applied load on
bolts.

a. Under the Results tab, click
Graph, in the Results plots
group.

b. Select all increments except
SC0

c. Select Constrain Forces,
Translational

d. Set X: to Global Variable,
Percent of Load

e. Click Target Entities

f. Pull down Target Entity >
Nodes

g. Select the control nodes of the
bolts.

h. Click Apply

Step 21. Post Processing (Cont.)
a

b

c

d

e

f

g

h
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Step 21. Post Processing (Cont.)

Step 2
Bolt Lock

Step 3
Structural Load

Step 1
Bolt Pretension

B
o
lt

P
re
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a
d
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E
xt

e
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a
l
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d
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WORKSHOP B1
NORMAL MODES ANALYSIS
OF A PRESTIFFENED BLADE
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• Workshop Objectives

– Perform a nonlinear static analysis and a normal modes analysis. Plot von
Mises stresses and normal modes.

– Define a stress-strain curve for material plasticity.

• Software Version

– Patran 2013

– MSC Nastran 2013.1

• Required

– Blade_model.bdf

• Problem Description

– In this exercise you will simulate the vibration of rotating fan blades of a jet
engine . The FEM nodes and elements will be imported as a MSC Nastran
data file. The model length unit is a meter.

– The analysis will be performed in two steps. In the first step, a nonlinear static
analysis will be performed to compute the stresses in the blade due to a
rotational speed of 133.3 revolutions per second. In the second step, the
normal modes and frequencies of the pre-stressed blade will be computed.

– Once the analysis is complete, the stresses and the normal modes will be
plotted.
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• Suggested Exercise Steps

1. Create a new database called blade.

2. Import model blade_model.bdf

3. Fix all translations and rotations at the left end of the blade.

4. Create an inertial load in the Z direction where the rotational velocity is
133.3.

5. Create a stress vs. strain field for plasticity with the following values:

6. Plot the field.

7. Create a steel material with 2.1e11 Elastic Modulus, 0.3 Poisson Ratio, and
7800 density.

• Define an elastoplastic constitutive model and apply the plasticity field.

8. Create a 2D shell property for the model.

• Apply steel material.

• Thickness = 0.0025

• Select Large Strain for Nonlinear Formulation (SOL400)

• Apply to entire model.

Strain Value

0 2e8

0.691 5e8

1 6e8
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• Suggested Exercise Steps (Cont.)

9. Create and run an implicit nonlinear analysis.

• In Solution Parameters select Solution Type SOL400 and Assumed Strain.

• Select .op2 as results output format.

• Create a NL_static subcase.

• In Load Increment Parameters, set the number of increments to 10.

• Select to output element strains.

• Create a modes subcase with a normal modes analysis type and 5 desired
roots.

• Deselect the default subcase and select the NL_static and modes subcases.

• Run analysis.

10.Attach .op2 result file.

11.Plot the von Mises stress superimposed on the deformed shape for the
final nonlinear result case.

12.Plot the deformed shape of the first mode.

13.Quit Patran.



NAS400, Workshop B1, January 2015
Copyright© 2015 MSC.Software Corporation

WSB1 - 6

Create a new database.
Name it blade.db.

a. Pull down File > New.

b. Enter blade as the file
name.

c. Click OK.

d. Confirm MSC Nastran as
the Analysis Code.

e. Click OK.

Step 1. Create a New Database

a

b c

d

e
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Import the FEM model.

a. Pull down File > Import.

b. Select MSC Nastran Input as
the Source.

c. Select blade_model.bdf.

d. Click Apply (click OK on the
File Import Summary).

Step 2. Import the FEM Mesh

a

c

d

b
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Create the fixed boundary
condition at the left edge.

a. Under the Loads/BCs tab, click
Displacement Constraint in
the Nodal group.

b. Enter fixed for New Set Name.

c. Click Input Data.

d. Enter <0 0 0> for the
Translations.

e. Enter <0 0 0> for the Rotations.

f. Click OK.

g. Click Select Application
Region.

Step 3. Create the Displacement Boundary
Condition

d

e

b

c

f

g

a
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a. Pull down Select to FEM.

b. Drag a rectangle to select the nodes at the root of the
blade.

c. Click Add.

d. Click OK.

e. Click Apply.

Step 3. Create the Displacement Boundary
Condition (Cont.)

e

b

a

c

d
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Create an inertial load in the Z direction where the rotational
velocity is 133.3.

a. Click Inertial Load in the Element Uniform group.

b. Enter spin for New Set Name.

c. Click Input Data.

d. Enter <0, 0, 133.3> for the Rot Velocity.

e. Click OK.

f. Click Apply

Step 4. Apply the Inertial Load

d

e

b

c

f

a
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Define the Stress vs. Plastic Strain field for the
steel material.

a. Under the Properties tab, click on Material
in the Fields group.

b. Enter Plasticity for Field Name.

c. Uncheck Temperature (T) under Active
Independent Variables.

d. Check Strain (e).

e. Click Input Data…

f. Enter the following data as shown:

g. Click OK.

h. Click Apply.

Step 5. Create a Field for Stress vs. Plastic
Strain

b

c
d

e

g

f

a

Strain(e) Stress

0.0 2.0E8

0.691 5.0E8

1.0 6.0E8

h
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Plot the Stress vs. Plastic Strain Data.

a. Pull down Action to Show.

b. Select Plasticity.

c. Click Specify Range.

d. Check Use Existing Points.

e. Click OK.

f. Click Apply.

g. Click Cancel on the Plotted Curves form.

h. Click Unpost Current XYWindow when finished
viewing the data.

Step 6. Plot the Stress vs. Plastic Strain Data

a

b

f

c

d

e

h

g
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Create material properties for steel.

a. Click Isotropic in the Isotropic
group.

b. Enter steel for Material Name.

c. Click Input Properties.

d. Enter 2.1E11 for the Elastic
Modulus.

e. Enter 0.3 for the Poisson Ratio.

f. Enter 7800 for the Density.

g. Click OK.

h. Click Apply.

Step 7. Create the Steel Material Property

d
e

f

g

a

b

c

h
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a. Select steel under the Existing
Materials list.

b. Pull down Elastoplastic for
Constitutive Model

c. Verify that Stress/Strain
Curve is selected for Nonlinear
Data Input.

d. Click in the Stress/Strain
Curve box.

e. Select Plasticity

f. Click OK.

g. Click Apply.

Step 7. Create the Steel Material Property (Cont.)

b

d

e

f

c

a

g
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Create a nonlinear shell element
property with steel as the material
and thickness of 0.0025.

a. Click Shell in the 2D Properties
group.

b. Enter blade for the Property
Set Name.

c. Click Input Properties.

d. Click on the Mat Prop Name
icon.

e. Select steel.

f. Enter 0.0025 for Thickness.

g. Pull down Large Strain for
Nonlinear Formulation
(SOL400).

h. Click OK.

Step 8. Create the Element Properties

a

b

c

d

e

f

g

h



NAS400, Workshop B1, January 2015
Copyright© 2015 MSC.Software Corporation

WSB1 - 16

a. Click Select Application Region.

b. Click Shell element on the Picking Filters toolbar.

c. Select all the elements.

d. Click Add

e. Click OK.

f. Click Apply.

g. Click on YES for ALL on the pop-up Message form.

Step 8. Create the Element Properties (Cont.)

c

d

g

e

f

a

b
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Create and run an implicit
nonlinear analysis:

a. Under the Analysis tab click on
Entire Model in the Analyze
group.

b. Enter blade for Job Name.

c. Click on Solution Type.

d. Select IMPLICIT NONLINEAR.

e. Click Solution Parameters.

f. Click Results Output Format.

Step 9. Set up the Analysis

f

b

c

d

e

a
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a. Select OP2

b. Click OK

c. Click OK

d. Click OK

Step 9. Set up the Analysis (Cont.)

a

b c
d
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a. Click on Subcases.

b. Enter NL_Static for
Subcase Name.

c. Click on Subcase
Parameters.

d. Pull down Large
Displacement/ Large
Strains for Nonlinear
Geometric Effects.

e. Click on Load
Increment Parameters.

Step 9. Set up the Analysis (Cont.)

e

b

c

d

a
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a. Pull down Fixed for Increment
Type

b. Enter 10 for Number of
Increments

c. Click OK

d. Click OK

Step 9. Set up the Analysis (Cont.)

d

a

b

c
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a. Click on Output Requests.

b. Select Element Strains.

c. Click OK.

d. Click Apply.

Step 9. Set up the Analysis (Cont.)

a

b

c d
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a. Click on Default under
Available Subcases.

b. Select Normal Modes as
Analysis Type.

c. Enter Modes for Subcase
Name.

d. Click on Subcase Parameters.

e. Enter 5 for Number of Desired
Roots.

f. Click OK.

g. Click Apply.

h. Click Cancel.

Step 9. Set up the Analysis (Cont.)

e

f

a

b

c

d

g h
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a. Click on Subcase Select.

b. Select NL_Static.

c. Select Modes.

d. Unselect Default.

e. Click OK.

f. Click Apply.

Step 9. Set up the Analysis (Cont.)

d

b

e

c

Be sure to select NL_Static before Modes
(Analysis Chaining: nonlinear static analysis

followed by normal modes analysis).

a

f
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Once the analysis is complete,
attach the results to the database.

a. Under the Analysis tab click
Attach Output2 in the Access
Results group.

b. Click Select Results File.

c. Select blade.op2.

d. Click OK.

e. Click Apply.

Step 10. Attach the Results

c

d

a

b

e
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Post-process the von Mises
stresses.

a. Under the Results tab click on
Fringe/Deformation in the
Quick Plot group.

b. Select the Non-linear Result
Case.

c. Select Stress Tensor, for the
Fringe Result.

d. Select Displacements,
Translational for the
Deformation Result.

e. Click Apply.

Step 11. Plot the Stress Results

a

b

c

d

e
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Post process the normal modes.

a. Select the Mode 1 Result
Case.

b. Unselect Stress Tensor, for
the Fringe Result.

c. Select Eigenvectors,
Translational for the
Deformation Result.

d. Click Apply.

Step 12. Plot the Modes

a

b

d

c

Hold Ctrl to Unselect an Entry
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* Obtained by changing the rotational speed to 1.E-6

Normal Modes Results Summary

Mode Frequency
(Pre-Stiffened)

Frequency
(un-stiffened*)

1 1.59E2 8.83E1

2 1.65E2 3.00E2

3 4.89E2 8.44E2

4 8.53E2 1.15E3

5 1.26E3 1.98E3
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Step 13. Quit Patran
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WORKSHOP B2
DYNAMIC COLLAPSE OF A CYLINDER
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• Workshop Objectives

– Perform Nonlinear Transient Dynamic Analysis on a cylinder.

– Analyze the dynamic collapse of the cylinder. Examine the resultant
stresses and deformations

• Software Version

– Patran 2013

– MSC Nastran 2013.1

• Files Required

– cylinder_model.ses
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• Problem Description

– In this exercise, we analyze the dynamic collapse of a cylinder. The 0.08
meter long cylinder (radius = 0.02 m ; thickness = 0.0131 m) is compressed
axially by two rigid bodies, one of which is fixed and the other moving with a
velocity of 50 m/s. The purpose of the analysis is to examine the stresses
and deformations. The cylinder is made of an elasto-plastic material with
linear work hardening. We model the cylinder here with a 100x3 mesh of 4-
noded, 2D solid axisymmetric (CQUADX) elements.

– The non-linear material properties for the elasto-plastic material are as
shown:

• Elastic Modulus = 2.05E11. Poisson Ratio = 0.3. Density = 7800.

Strain(e) Stress

0.0 2.0E8

1.0 6.0E8

2.0 6.1E8
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• Suggested Exercise Steps

1. Open a New Database.

2. Run the cylinder_model.ses file.

3. Create a time dependent load case.

4. Define the cylinder as a Deformable Contact Body.

5. Define the two walls as Rigid Contact Bodies.

• Velocity of -50 for upper_wall.

6. Preview the rigid body motion.

7. Create material property with tabular input for plastic as shown in the
problem description.

8. Create a material with elastic and plastic properties.

• Elastic Modulus = 2.05E11. Poisson Ratio = 0.3. Density = 7800.

9. Apply 2D Solid properties to the cylinder.
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• Suggested Exercise Steps (Cont.)

10. Set up and run the implicit nonlinear analysis.

• Set friction type to Bilinear Coloumb.

• Select the .op2 results output format.

• Create a Trans_Dynamic subcase and apply these properties: Time Step Size
= 2E-6. Total Time = 8E-4. Matrix Update Method = Pure Full Newton.
Number of Iterations per Update = -1. Turn on Displacement Error and Vector
Component Method in load increment parameters.

• Select Element Strains, Non-Linear Stress and Contact Results output request.

• Unselect the Default subcase and select the Trans_Dynamic subcase.

• Edit the exported input file.

11. Access the nonlinear results.

12. View Results.

• Create a logarithmic strains fringe result and displacements, translational
deformation result quick plot for the final result case.

• Create a Cauchy stresses, NonLinear Output fringe result and
displacements, translational deformation result quick plot for the final result
case.

13. Quit Patran.
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Open a new database named
cylinder.db:

a. Pull down File > New.

b. Type cylinder as File name.

c. Click OK.

d. Click OK to select
MSC.Nastran as the Analysis
Code.

Step 1. Open a New Database

b c d

a
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Run the provided session file.

a. Pull down File > Session >
Play.

b. Select cylinder_model.ses
as the File name.

c. Click Apply.
(This action will run the
session file. Please do not
interrupt it.)

Step 2. Run the Provided Session File

a

b

c
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Create a Time Dependent Load Case.

a. Under the Loads/BCs tab, click on Create Load Case
in the Load Cases group.

b. Enter Trans_Dynamic for the Load Case Name.

c. Pull down Time Dependent for the load case Type.

d. Click Apply.

Step 3. Create a Time Dependent Load Case

a

b

c

d

a
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Create a deformable contact body
for the cylinder.

a. Click Deformable in the
Contact Bodies group.

b. Verify Deformable Body as
the Option.

c. Enter cylinder as the New Set
Name.

d. Select 2D as the Target
Element Type.

e. Click Select Application
Region.

f. Select the cylinder surface.

g. Click Add.

h. Click OK.

i. Click Apply.

Step 4. Define the Deformable Contact Body

b

c

d

e

g

h

i

f

a
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Create rigid contact bodies.

a. Click Rigid in the Contact Bodies group.

b. Verify Rigid Body as the Option.

c. Enter lower_wall as the New Set Name.

d. Select 1D as the Target Element Type.

e. Click Input Data.

f. Check Flip Contact Side (Flipping the Contact
Side is needed, because of the orientation of the
curve representing this wall).

g. Enter 0.1 for the Friction Coefficient (MU).

h. Click OK.

Step 5. Define the Rigid Contact Bodies

b

c

d

e

f

g

h

a
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a. Click Select Application
Region.

b. Click in the Select Curves box

c. Select the bottom curve
defining the rigid surface
(Curve 1).

d. Click Add.

e. Click OK.

f. Click Apply.

Step 5. Define the Rigid Contact Bodies (Cont.)

a

b

c

d

f
e
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a. Enter upper_wall as the New Set
Name.

b. Click Input Data.

c. Uncheck Flip Contact Side.

d. Enter 0.0 for the Friction
Coefficient (MU).

e. Enter <0, -50, 0> for the Velocity
(vector).

f. Click OK.

Step 5. Define the Rigid Contact Bodies (Cont.)

c

d

e

f

a

b
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a. Click Select
Application Region

b. Click in the Select
Curves box.

c. Select the top curve
defining the rigid
surface (Curve 2).

d. Click Add.

e. Click OK.

f. Click Apply.

Step 5. Define the Rigid Contact Bodies (Cont.)

b

c

a

d

f

e
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Preview the Rigid Body Motion.

a. Click Preview Motion.

b. Select upper_wall.

c. Enter 8e-4 for End Time.

d. Click Preview Motion.

e. Click OK after reviewing the
motion.

Step 6. Preview the Rigid Body Motion

b

c

d

e

a
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Create a field for the elastic-
plastic material data.

a. Under the Properties tab,
click on Material in the
Fields group.

b. Enter Plastic_s_e as the
Field Name.

c. Uncheck Temperature (T)
under Active Independent
Variables.

d. Check Strain (e).

e. Click Input Data.

f. Enter the data as shown.

g. Click OK.

h. Click Apply.

Step 7. Create Material Property with Tabular
Input

a

b

c

e

h

d

The 1D Material Scalar Table Data form needs to
be filled out as shown in the table. To fill in the
table, click on the cell you wish to edit, enter the
value in the Input Data databox and press
<Enter>. The table will automatically tab down.

f

g

Strain(e) Stress

0.0 2.0E8

1.0 6.0E8

2.0 6.1E8
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Create a material, with elastic and
plastic properties.

a. Click on Isotropic in the
Isotropic group.

b. Enter Mat1 as the Material
Name.

c. Click Input Properties.

d. Select Linear Elastic as the
Constitutive Model.

e. Enter 2.05E11 as the Elastic
Modulus.

f. Enter 0.3 as the Poisson Ratio.

g. Enter 7800 as the Density.

h. Click OK.

i. Click Apply.

Step 8. Create the Material with Elastic and
Plastic Properties

d

e
f

g

h

a

b

c

i
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b

c

d

e

f

a. Click Input Properities.

b. Pull down Elastoplastic for
Constitutive Model and
Stress/Strain Curve for
Nonlinear Data Input.

c. Verify that Strain Rate Method is
set to None.

d. Click in the Stress / Strain Curve
panel.

e. Select Plastic_s_e.

f. Click OK.

g. Click Apply.

Step 8. Create the Material with Elastic and
Plastic Properties (Cont.)

a

g
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Apply properties:

a. Click on 2D Solid in the
2D Properties group.

b. Enter cylinder for
Property Set Name.

c. Modify Options to
Axisymmetric and
PLPLANE.

d. Click Input Properties.

e. Click the Mat Prop
Name Icon.

f. Select Mat1.

g. Click OK.

Step 9. Apply Properties

f

b

c

d
g

a

e
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a. Click Select
Application Region.

b. Click in the Select
Members box.

c. Select the cylinder
(Surface 1)

d. Click Add.

e. Click OK.

f. Click Apply.

Step 9. Apply Properties (Cont.)

a

b

c

d

e
f
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Set up the nonlinear Analysis job.

a. Under the Analysis tab, click
on Analysis Deck in the
Create Group.

b. Enter cylinder as the Job
Name.

c. Click Solution Type.

d. Select Implicit Nonlinear as
Solution Type.

e. Click Solution Parameters.

f. Verify that SOL400 Run is
checked.

g. Uncheck Assumed Strain.

Step 10. Set Up the Analysis

f

g

d

e

a

b

c
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c

d

a. Click Contact Parameters.

b. Click Friction…

c. Pull down Bilinear Coulomb
for Type.

d. Click OK.

e. Click OK.

Step 10. Set Up the Analysis (Cont.)

b

e

a
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c

a

b

a. Click Results Output Format.

b. Check OP2.

c. Check Print.

d. Click OK.

e. Click OK.

f. Click OK.

Step 10. Set Up the Analysis (Cont.)

d
e

f
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b

c
d

e

a. Click Subcases.

b. Click on Trans_Dynamic
under Available
Subcases.

c. Pull down Transient
Dynamic for Analysis
Type.

d. Click on Subcase
Parameters.

e. Verify Large
Displacement/Large
Strains is selected for
Nonlinear Geometric
Effects.

Step 10. Set Up the Analysis (Cont.)

a
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a

b

c

e

d

a. Click Load Increment
Parameters.

b. Verify that Increment Type is
set to Fixed.

c. Enter 2E-6 for Time Step Size.

d. Enter 8E-4 for Total Time.

e. Click OK.

Step 10. Set Up the Analysis (Cont.)
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a

b
c

d

e

f

a. Click Iteration Parameters

b. Pull down Pure Full Newton
for Matrix Update Method.

c. Enter -1 for Number of
Iterations per Update.

d. Check Displacement Error.

e. Check Vector Component
Method.

f. Click OK.

g. Click OK.

Step 10. Set Up the Analysis (Cont.)

g
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b

c

a

a. Click Output Requests.

b. Select Element Strains, Non-
Linear Stress and Contact
Results under Select Result
Type.

c. Click OK.

d. Click Apply.

e. Click Cancel.

Step 10. Set Up the Analysis (Cont.)

ed
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c

d

a. Click Subcase Select.

b. Select Trans_Dynamic
from the Available
Subcases.

c. Unselect Default by clicking
on it under Load Steps
Selected.

d. Click OK.

e. Click Apply.

Step 10. Set Up the Analysis (Cont.)

b

a

e
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BEGIN BULK
$ Direct Text Input for Bulk Data
PARAM POST 1
PARAM PRTMAXIM YES
BCPARA,0,NLGLUE,1,NBODIES,3,FTYPE,6
PARAM LGDISP 1
TSTEPNL 1 400 2.-6 PFNT -1 UV

.01

BEGIN BULK
$ Direct Text Input for Bulk Data
PARAM POST 1
PARAM PRTMAXIM YES
BCPARA 0 NLGLUE 0 FTYPE 6
PARAM LGDISP 1
TSTEPNL 1 400 2.-6 PFNT -1 UV

.01

Modify the cylinder.bdf file.

a. Open the cylinder.bdf file in a text editor. It will be located in the same folder
you saved the Patran database file.

b. Locate the “BCPARA 0 NLGLUE 0 FTYPE 6” line.

c. Change the line to “BCPARA, 0, NLGLUE, 1, NBODIES, 3, FTYPE, 6”. Save
the file as cylinder.bdf. This will set the friction type to Bilinear Coulomb.

Step 10. Set Up the Analysis (Cont.)

a

b

c
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Submit the modified job to MSC Nastran.

a. Click Submit in the Existing Deck
group.

b. Click Apply.

Step 10. Set Up the Analysis (Cont.)

a

b
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c

d

Read (Attach) results.

a. Click on Attach Output2 in the
Access Results group.

b. Click on Select Results File.

c. Select cylinder.op2.

d. Click OK.

e. Click Apply.

Step 11. Access the Nonlinear Results

a

b

e
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Create a logarithmic strains fringe plot and a
displacements, translational deformation plot for the
final result case:

a. Under the Results tab, click
Fringe/Deformation in the Quick Plot group.

b. Under Select Result Cases, select the last result
case, Trans_Dynamic, A1:Time = 0.0008.

c. Select Logarithmic Strains, as the Fringe
Result.

d. Select Displacements, Translational.

e. Click the Deform Attributes icon.

f. Change the Scale Interpretation to True Scale.

g. Uncheck Show Undeformed

h. Click Apply.

Step 12. View Results

a

f

g

h

e

b

c

d
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Step 12. View Results (Cont.)
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a

a. Click the Select Results icon.

b. Select Cauchy Stresses, NonLinear Output
as the Fringe Result.

c. Click Apply.

Step 12. View Results (Cont.)

c

b
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Step 12. View Results (Cont.)
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Step 13. Quit Patran
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